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I 

 

UM软件常见问题系列70篇文章连载于同算科技微信公众号（2017-2022）。

本文按发布顺序进行整理汇编，以便用户查阅。 

请用户在使用软件过程中优先从文中查询是否有相同或相近的问题，如

果本文中的解答无法解决您遇到的实际问题，请将完整模型打包发送到技术

服务邮箱：tongsuan@qq.con，并提供详细的问题描述。 

欢迎加入新的 QQ 交流群 528482401（262743795 已满）。 

编者强烈建议初学者按下列顺序学习 UM 软件： 

1、学习《UM 培训教程》，快速上手。 

2、学习《UM 软件入门系列教程》，熟悉操作。 

3、学习《UM 软件强基训练教程》，巩固基础。 

4、阅读用户手册 1-4 章，了解理论，总体把握。 

5、精读专业模块对应的用户手册，深入研究。 

mailto:tongsuan@qq.con
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001. 试用 License 的申请和使用 

一、申请 License 

1、本机第一次安装 UM 软件，即可直接使用，在 30 天之内无需注册，使用限制为 

600 次，软件功能无限制。 

2、一个月或 600 次试用期结束后，运行 UM 软件时，会自动弹出注册界面（图 001-

1），即免费试用已过期，需要申请 license 方可继续试用。 

 

图 001-1 注册界面 

3、在 Registration name 处输入注册用户名（自拟一个），比如 Lei。 

4、点击 Crete registration request file 生成 request.dat 文件，如图 001-2。 

 

图 001-2 生成 request.dat 文件 
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5、点击 确定 ，根据提示路径 C:\Users\Public\Documents\UM Software Lab\Universal 

Mechanism\9，找到 request.dat。 

6、将该 request.dat 文件和本人有效学生证内外页彩图（最好将图片压缩处理，以减

少空间占用），一并发送到 UM 许可管理员邮箱 registration@universalmechanism.com，

同时用英语告知你所在的学校、学院、专业、姓名。 

7、以上工作确保无误，请耐心等待邮件回复，一般在 1-7 天，若超过一周都未收到回

复请联系 QQ 群管理员。 

二、加载 License 

1、收到管理员回复邮件后，请先下载附件 license.dat 文件到已知文件夹，如图 001-

3。 

 

图 001-3 成功申请到 License 

2、点击桌面图标 UM Input 或 UM Simulation，注册窗口如 001-1 所示，点击 Load 

License file，选择下载到的 license.dat（注：许可文件与申请文件是对应的，只能用于同一

台机子）。 

3、预计会有两种界面出现，下面分别说明。 

（1）出现界面如图 001-4 所示，那么恭喜注册成功，重启程序即可。 

 

图 001-4 license.dat 注册成功 
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（2）出现界面如图 001-5 所示，则说明注册失败，主要原因是因为用户权限不够。 

 

图 001-5 无法复制 

解决方法一：根据提示，手动将 license.dat文件复制到路径C:\ProgramData\UM Software 

Lab\Universal Mechanism\9\x64 下面。 

C 盘下面的 ProgramData 文件夹默认为隐藏状态，请设置为显示即可，如图 001-6。 

 

图 001-6 显示隐藏文件夹 

解决方法二：在桌面选中 UM Input 或 UM Simulation，点右键，选择以管理员身份运

行，如图 001-7。 

 

图 001-7 以管理员身份运行 

在弹出的注册窗口点击 Load License file，加载 license.dat，直至出现图 001-4 窗口，

恭喜注册成功。 
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002. 如何在后处理添加均方根统计函数 

UM Simulation 提供了一系列函数用于后处理统计分析，这些函数在 Table processor 工

具中，并支持用户扩展。本文以均方根函数为例，介绍如何添加自定义的统计函数。 

1、找到编译后的均方根统计函数。我们在 QQ 群(262743795 和 528482401)共享文件

已上传编译好的均方根统计函数，包含 32 位和 64 位，如图 002-1，请下载与软件版本对

应的函数； 

 

图 002-1 从 QQ 群下载均方根函数 

2 、若在 Windows 7 中使用 32 位的 UM 软件，则将 RMS32.dll 复制到

C:\Users\Public\Documents\UM Software Lab\Universal Mechanism\7\x32\Plugins 文件下； 

若 在 Windows 10 中 使 用 64 位 的 UM 软 件 ， 则 将 RMS64.dl 复 制 到

C:\Users\Public\Documents\UM Software Lab\Universal Mechanism\9\Plugins 文件夹下，如图

002-2； 
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图 002-2 添加相应均方根函数到指定文件夹 

3、运行 UM Simulation，从 Tools 菜单或者工具栏图标打开 Table processor，可找到该

统计函数，如图 002-3。 

 

图 002-3 Table processor 下寻找均方根统计 

此时，我们需要的统计函数就添加成功了。 
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003. 参数化模型为什么在前处理中修改参数值后 

在后处理中却没有修改？ 

对于参数化建模模型，用户常常会遇见一个问题，为什么在 UM Input 中修改数值后却

在 UM Simulation 中却没有修改？下面以两个车轮间距变化为例讲述此问题： 

一、问题描述： 

1、在 UM Input 建立两个轮对，分别相对 Base0 移动距离为 x1(=1)、x2(=-1)，如图 003-

1； 

 

图 003-1 UM Input 建立两个轮对 

2、进入 UM Simulation，在 Analysis→Simulation→Identifiers 下我们可以看见设置的

标识符，其中 x1=1 表示轮对 1 向前移动 1 米，x2=-1 表示轮对 2 向后移动-1 米，如图 003-

2； 
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图 003-2 UM Simulation 仿真 

3、假设现在两轮对之间距离为 4 米，我们在 UM Input 修改，x1 修改为 2，x2 修改为

-2，如图 003-3； 

 

图 003-3 UM Input 修改标识符数值 

4、保存之后进入 UM Simulation，在 Analysis→Simulation→Identifiers 下面查看修改

后的标识符，如图 003-4； 
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图 003-4 UM Simulation 查看变量 

我们对比发现，UM Simulation 中的标识符数值依旧没有修改，但是自己的确在 UM 

Input 中修改过了，如图 003-1 和图 003-3，这是为什么呢？ 

二、解决方法 

打开模型文件夹，我们发现有一些 last 文件，这些文件记录了上一次仿真的工况配置，

下次仿真时默认以该配置加载，如图 003-5 和图 003-6。 

 

图 003-5 模型文件夹下包含的文件 

 

图 003-6 记录标识符的 last.par 文件 
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解决方法一：在 UM Input 中修改标识符的数值，并删除原来的 last.par，如图 003-7； 

 

图 003-7 解决方法一 

解决方法二：打开 last.par 文件，找到相应标识符并修改、保存，如图 003-8； 

 

图 003-8 解决方法二 

解决方法三：直接在 UM Simulation 里修改标识符的数值，如图 003-9。 

 

图 003-9 解决方法三 
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004. 如何定义变量并保存结果 

UM Simulation 计算过程中可以实时看到各个变量的时程曲线，然而计算完成后只要

点击 Interrupt 按钮，所有数据瞬间消失，模型文件夹里也没有结果文件生成，如图 004-1

和图 004-2。 

 

图 004-1 点击 Interrupt 之前 

 

图 004-2 点击 Interrupt 之后 

下面我们详细介绍如何保存变量结果： 

一、变量创建、保存、仿真 

1、运行 UM Simulation，打开任意模型； 

2、选择主菜单 Tools→List of variables，如图 004-3； 
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图 004-3  

3、在 List of variables 界面，如图 004-4 红色框图所示，依次为添加、删除、重命名。

依次添加定义不同变量组，如图 004-5； 

 

图 004-4 

 

图 004-5 

4、选择主菜单 Tools→Wizard of variables，依次创建一些变量并拖动到相应 List of 

variables 的变量组下面，如图 004-6； 
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图 004-6 

5、点击 List of variables 保存，保存创建好的变量，如图 004-7； 

 

图 004-7 

6、选择主菜单 Analysis→Simulation，打开仿真控制界面，在 Object variables 页面加

载已创建好的变量文件，如图 004-8 和图 004-9； 
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图 004-8 

 

图 004-9 

7、点击 Integration 开始仿真，可关闭所有动画和绘图窗口以提高仿真速度，待仿真完

成，依次点击 Interrupt、Close，关闭 UM Simulation，如图 004-10； 
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图 004-10 

8、至此，仿真工作完成。打开模型文件夹，会发现多出现了.tgr 和.sgr 两个文件，而

它就是保存的结果，如图 004-11； 

 

图 004-11 
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二、查看仿真结果 

1、运行 UM Simulation； 

2、选择主菜单 Tools→List of calculated variables，打开前面计算得到的结果文件，如

图 004-12； 

 

图 004-12 

3、选择主菜单 Tools→Graphical window…打开一个绘图窗口，可将结果列表中的变

量拖动到绘图窗口显示，如图 004-13； 

 

图 004-13 

4、根据需要，再对数据进行其他分析（如滤波、统计、输出等）。 

因此，只需有.tgr 和.sgr 文件，就可以用 UM Simulation 程序看结果（无需加载模型）。 
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005. 基于 UM FEM 和 UM Monorail 的公路车桥耦合仿真 

基于 UM FEM/Monorail 模块不仅可以进行单轨车辆和轨道梁的动态耦合仿真，还可

进行公路车桥耦合仿真分析，下面让我们一起探索这一功能： 

1、首先确定自己电脑有 UM FEM/Monorail 模块，以及 UM Monorail Train 模块； 

2、导入桥梁柔性体子结构，并添加备注@monorail=true@（具体参见帮助第 26 章第

37 页），如图 005-1 所示； 

 

图 005-1 指定调用 FEM/Monorail 模块 

3、添加车辆子系统，并添加备注 Monorail（参见帮助第 26 章第 5 页），如图 005-2； 

 

图 005-2 指定调用单轨模块 
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4、在 UM Simulation 设置轮胎与有限元模型的相互作用（具体参见帮助第 26 章 43

页），如图 005-3；  

 

图 005-3 设置相互作用 

5、查看桥梁结果，确保二者已相互作用，如图 005-4； 

 

图 005-4 公路车桥耦合仿真 

如欲获得本例学习模型，请联系 QQ 群管理员。 
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006. 如何设置车辆仿真运行初始速度的单位？ 

有时候，同一个模型，软件版本也相同，为何在别人电脑上仿真没问题，在自己电脑

上仿真时却提示 Wheelset 1 is out of rail 等问题，如图 006-1。 

 

图 006-1 仿真错误提示 

对比发现，参数均相同，速度数值也相同，这是为什么呢？ 

我们都知道，常用速度单位有 km/h 和 m/s 两种，出现上述问题有可能是由于两个电

脑上程序的默认速度单位不同所导致。 

下面我们用一个轮对通过曲线为例说明此问题，如图 006-2。 

 

图 006-2 单轮对通过曲线 

1、速度数值为 40，单位为 km/h 时，轮对安全通过曲线，如图 006-3； 
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图 006-3 速度单位为 km/h 时仿真 

2、速度数值为 40，单位为 m/s 时，轮对发生脱轨，如图 006-4； 

 

图 006-4 速度单位为 m/s 时仿真 

因此，在仿真时需要特别注意速度单位，查看是否正确。那么速度单位在在哪里设置

呢？ 

路径为：UM Simulation→Tools→options...→General→Speed unit，如图 006-5。 
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图 006-5 速度单位设置 

备注：这里的速度单位只对铁路、公路、单轨和履带车辆的 v0（初始速度）参数有效，

便于设置不同仿真工况，而最终得到的所有计算结果均为国际单位制（kg,m,s,N...）。 

好消息，最新版本的速度设置选项在工具栏上，设置更加便捷。 

  



                                                    

第 21 页 
 

007. 车辆曲线通过如何选择正确的参考系？ 

由于研究需要，我们常常需要考察车辆通过曲线或 S 曲线时位移、速度及加速度等变

量。 

下面我们以一节动车通过某 S 曲线为例说明此问题，如图 007-1。 

 

图 007-1 车辆通过 S 曲线 

打开变量向导，按其默认的 Linear variables 创建车体某点横向位移，如图 007-2。 

 

图 007-2 在默认情况下创建变量 
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仿真得到横向位移时程曲线，如图 007-3。 

 

图 007-3 默认坐标系下仿真结果 

观察图 007-3，我们发现车体横向位移达到了 72m，同时呈现 S 曲线特性。这是为什

么呢？而我们想知道车体在沿线路方向的横向位移，显然不是图 007-3 所示 S 曲线。 

出现图 007-3 曲线，是因为变量是在默认的 Base0 坐标系下创建的，而这个 Base0 坐

标系是固定的，不会随线路走向变化而变化，如图 007-4。 

 

图 007-4 变量向导默认坐标系为 Base0 坐标系 
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这时候就必须在轨道坐标系（Track coordinate system）中定义变量了，这个坐标系实

际是轨道上的一系列坐标系，线路中心线上每一处都有这么一个局部坐标系，也可理解为

动态坐标系。同样方法，在 Track coordinate system 创建车体某两点横向位移，如图 007-5。 

 

图 007-5 在轨道坐标系下创建变量 

仿真得到横向位移时程曲线，如图 007-6。 

 

图 007-6 轨道坐标系仿真结果 

观察图 007-6 我们看到，这是个正确的结果。 

那么什么情况下才使用轨道坐标系呢？一般而言，车辆在通过曲线线路时，如果你想

考察车体、转向架、轮对、轴箱等车上部件相对轨道的（角）位移、（角）速度、（角）加

速度时需要使用轨道坐标系。  
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008. 如何设置时域仿真终止条件？ 

对于 UM 后处理仿真的终止条件，我们有时需要是 Time（时间），有时需要是 Distance

（距离）。 

对于车辆模型，首次进入仿真，软件默认终止条件为 Distance（距离），如图 008-1。 

 

图 008-1 默认终止条件为 Distance 

如果需要修改为 Time（时间），则点击右侧 t，软件自动改变终止条件为 Time，如图

008-2。 

 

图 008-2 修改终止条件为 Time 
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现在，如何将终止条件从 Time 修改回原来的 Distance 呢？ 

操作方法如下：  

1、对于机车车辆模型：打开变量向导，选择 Railway vehicle，创建变量 Distance，拖

动此变量到 Solver 下的终止条件，软件将自动替换 Time 为 Distance，如图 008-3； 

 

图 008-3 机车车辆模块修改终止条件为 Distance 

2、对于单轨车辆模型，该 Distance 变量位于 Monorail train 下，如图 008-4； 

 

图 008-4 单轨车辆 Distance 位置 
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3、对于公路车辆模型，该 Distance 变量位于 Road vehicle 下，如图 008-5； 

 

图 008-5 公路车辆 Distance 位置 

4、对于履带车辆模型，该 Distance 变量位于 Tracked vehicle 下，如图 008-6； 

 

图 008-6 履带车辆 Distance 位置 
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009. 如何在动画窗口显示动态的三维矢量图？ 

我们都知道，力、速度、加速度等是一个矢量，既有大小，又有方向，那么在 UM 软

件中如何显示出物体运动轨迹等三维矢量呢？ 

我们以粽子受到空气阻力时的平抛运动为例，介绍如何绘制三维矢量图，如图 009-1。 

 

图 009-1 粽子平抛平抛 

1、轨迹矢量图绘制：打开变量向导，选择 Linear variables，左侧选择粽子，Type 选

择 Coordinate，Component 选择 V，创建变量，拖动到动画窗口中，如图 009-2。 

 

图 009-2 轨迹创建 

在动画窗口点右键，选择 Position of vector list，再选择 Left，选中轨迹曲线双击，修

改颜色，如图 009-3。 
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图 009-3 显示矢量并修改颜色 

点击仿真，观察粽子下落轨迹图，如图 009-4。 

 

图 009-4 轨迹矢量图绘制 

2、阻力矢量图绘制：以相同的方法，创建阻力矢量，点击仿真，观察阻力矢量变化，

如图 009-5。 

 

图 009-5 阻力矢量图绘制 
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在动画窗口点右键，选择 Vector scales，可进行矢量显示大小调节，如图 009-6； 

 

图 009-6 矢量比例显示 

3、速度矢量图绘制：相同方法，创建速度矢量，观察速度矢量变化，如图 009-7； 

 

图 009-7 速度矢量图绘制 

4、加速度矢量图绘制：相同方法，创建加速度矢量，观察速度矢量变化，如图 009-8。 

 

图 009-8 加速度矢量图绘制 
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010. 如何设置绘图窗口曲线横坐标为距离？ 

使用 UM 进行时域仿真计算，缺省获得变量随时间变化的曲线，如图 010-1。 

 

图 010-1 默认横坐标绘图结果 

对于车辆或列车模型，我们想得到变量随车辆运行距离变化的曲线，该如何实现呢？ 

我们以某铁路车桥耦合案例，向大家介绍如何将绘图窗口的横坐标由 Time 设置为

Distance。 

1、修改实时仿真绘图窗口的横坐标 

在仿真开始前，通过主菜单 Tools-Wizard of variables 创建两个变量：桥梁垂向位移

（r:z）和列车运行距离（Distance），将其一并拖入一个绘图窗口（Tools-Graphic Window）。

在绘图窗口左侧选中 Distance 点右键，选择 Use variable for x-axis values，如图 010-2。 

 

图 010-2 设置横坐标为变量 

开始仿真，此时横坐标即为距离，如图 010-3。 

 

图 010-3 设置横坐标为变量绘图结果 
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备注：如需将横坐标切换回 Time，只需在绘图窗口左侧空白区点右键，然后选择 Use 

time for x-axis values。 

2、修改结果文件数据的横坐标 

在仿真开始前，定义好所有需要考察的动力学变量以及 Distance 变量，保存为变量列

表文件（.var）； 

加载变量列表，进行计算； 

计算完毕，读取结果文件，将 Distance 变量按图 010-4 所示拖入替换缺省的 Time，这

样从结果文件绘制的所有曲线其横坐标就是车辆运行距离了。 

 

图 010-4 设置绘图横坐标为距离 

按同样的方法，我们可以把任意变量设置为横坐标。  



                                                    

第 32 页 
 

011. 如何录制 AVI 动画？ 

一、录制动画窗口的动画：  

1、在计算前，点击动画窗口左上角“照相机”图标，选择 Save animation，如图 011-1。 

 

图 011-1 设置保存动画 1 

2、勾选 Save animation，可勾选 Low quality 以减小动画文件，点击 OK，如图 011-

2。 

 

图 011-2 设置保存动画 2 

3、点击仿真按钮 Integration，待仿真结束，点击 Interrupt，开始生成动画文件，随

后可在模型文件夹找到我们刚刚录制的动画文件（.avi），如图 011-3。 

 

图 011-3 保存动画结果 

注意：软件将自动截取屏幕上该区域，录制动画时，切勿再将其最小化。 
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二、录制绘图窗口的动画： 

1、将鼠标移动到绘图窗口上部，直到出现工具栏，点击左上角“大头针”图标，使工具

栏不再自动隐藏，如图 011-4。 

 

图 011-4 绘图窗口设置保存动画 1 

2、点击“照相机”图标，选择 Save animation，如图 011-5； 

 

图 011-5 绘图窗口设置保存动画 2 

3、勾选 Save animation 及 Low quality，点击 OK，点击仿真即可开始录制动画。 

我们可以发现，只要有“照相机”图标的动画窗口，我们都可以使用以上方法进行动画

录制。 

注：UM 8.5 以后版本的界面稍有不同。 
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012. 如何对仿真结果进行滤波？ 

UM Simulation 仿真得到大量的时程数据，我们常常需要对其进行滤波处理。 

下面向大家介绍如何使用 UM 自带的滤波器进行滤波。 

1、选择需要滤波的数据，拖入一个绘图窗口，如图 012-1； 

注：滤波时数据的横坐标必须是 Time。 

 

图 012-1 需处理的数据 

2、在绘图窗口右键，选择 Options，选择 Frequency filter，进行滤波器设置。这里我

们以低通波器为例：在 Filter type 下选择 Low-pass filter，在 Frequency band 设置 Higher 

frequency（截止频率）为 30Hz，点击 OK，如图 012-2； 

 

图 012-2 设置滤波器 
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3、选中要滤波的变量，右键，选择 Filter，执行滤波，如图 012-3； 

 

图 012-3 执行滤波 

4、这时，我们可以看到，绘图窗口多出一条曲线，这就是我们滤波后的数据（红色曲

线），如图 012-4； 

 

图 012-4 滤波后结果 

软件自带低通、高通、带阻、带通、矩形、巴特沃斯低通、巴特沃斯高通等滤波器，

可根据需要自己选择。 
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013. 如何输出计算结果数据？ 

我们知道有些期刊要求其论文图片必须是采用专业绘图软件输入图片，如 Origin 等，

那么如何将我们仿真计算的结果数据输出，以便导入到这些专业软件中呢？ 

下面我们以某车桥耦合计算结果为例介绍如何输出结果数据，如图 013-1。 

 

图 013-1 仿真得到的时程曲线 

一、输出到 EXCEL 表格并带绘图 

1、在绘图窗口选中变量点右键，选择 Copy as diagram to active MS Excel book，如图

013-2； 

 

图 013-2 设置输出结果类型 1 
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2、此时，MS Excel 将自动运行，并写入我们所选变量的结果数据，且根据缺省模板

绘制曲线图，如图 013-3； 

 

图 013-3 带图输出到 Excel 表格 

其中第一列为横坐标，第二列为纵坐标。 

备注：请先确认计算机已安装有 Microsoft Office 软件。 

二、输出到 EXCEL 表格不带图 

1、在绘图窗口选中变量点右键，选择 Copy as table to active MS Excel book，如图 013-

4； 

 

图 013-4 设置输出结果类型 2 
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2、此时，MS Excel 将自动运行，并写入我们所选变量的结果数据，但不绘制曲线图，

如图 013-5； 

 

图 013-5 不带图输入到 Excel  

三、输出到其他格式文本文件 

1、在绘图窗口选中变量点右键，选择 Save to file...，如图 013-6； 

 

图 013-6 设置输出结果类型 3 
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2、可根据需要选择格式，如图 013-7； 

 

图 013-7 设置输出结果类型 4 

3、默认输出.txt 文本文件，用记事本打开可以看到两列数据，第一列为横坐标，第二

列为纵坐标，横坐标与纵坐标之间有一“空格”分割，如图 013-8；  

 

图 013-8 输出到 txt 文本文件结果 

备注：%标记的行为备注。 
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014. 实时仿真如何让镜头一直跟随物体？ 

在 UM Simulation 里，动画窗口的镜头默认是固定在 Base0 坐标系，一旦物体运动超

出一定范围，我们就看不到它了，这时候就需要重新调整窗口或者设置镜头跟随。 

下面以单轮对通过某一小半径曲线为例介绍如何让动画窗口的镜头始终跟随轮对，如

图 014-1。 

 

图 014-1 单轮对通过某曲线 
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1、首次打开模型，软件默认动画显示镜头位于 Base0 上，不随模型的运动而运动，如

图 014-2； 

 

图 014-2 默认的镜头不跟随轮对 

2、在动画窗口点右键，选择 Window parameters...，如图 014-3； 

 

图 014-3 选择窗口参数菜单 
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3、在弹出页面下方 Follow the body...右侧点击手指按钮，然后从下拉菜单选择轮对子

系统的 WSet 物体，如图 014-4； 

 

图 014-4 设置显示镜头更随物体 

4、点击 Integration，我们可以看到，显示镜头将一直跟随模型实时显示，如图 014-

5； 
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图 014-5 显示镜头跟随物体实时显示 

另一种方法：先按下动画窗口工具栏的箭头图标，这样就激活了光标选择模式，然后

将光标移动到目标物体上(注：此时光标图标会发生变化，动画窗口下方的状态栏会显示当

前物体名称)，点右键，选择 Cameral follows (当前物体)即可。 

 

如果要取消跟随物体，可按第 2-3 步操作选择 Base0 即可（图 014-4）；或者直接在动

画窗口点右键，选择 Camera follows Base0。 

 

注：UM8.5 以后的版本通过右键菜单“Attach camera to body...”、“Cameras”和“Look 

at”选项来设置。 
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015. 为什么找不到外部子系统的原始模型？ 

我们知道，UM 软件支持子系统的调用和复制，能减少很多重复性的建模工作。UM 里

的子系统主要分为内部子系统（Included Subsystem）和外部子系统（External Subsystem）

两大类，内部子系统可以在最终模型里直接编辑，而外部子系统只能在原始模型中编辑。 

当我们在做车辆碰撞、车桥耦合等仿真分析时，需要调用外部子系统（从有限元软件

导出的 FEM 模型也属于一种外部子系统）进行建模，而在仿真时经常会出现找不到外部

子系统原始模型的错误提示（或者在自己电脑上仿真没问题，拷贝到别人电脑上仿真却出

现问题），如图 015-1。 

 

图 015-1 错误提示 

这句话的意思是：最终模型中的“桥梁”引用了一个名叫“Bridge”的外部子系统，但找

不到它的原始模型，问你是否去找它。 

对于这种问题，该如何解决呢？ 

例如：我们在桌面放有两个模型（一个模型是一个文件夹），名称分别为“车桥耦合”、

“bridge”，如图 015-2。 

 

图 015-2 两个模型 
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并且，在“车桥耦合”模型中调用了“bridge”模型（外部 FEM 子系统），如图 015-3； 

 

图 015-3 调用外部 FEM 子系统 

此时，若直接进入 UM Simulation 仿真，出现图 1 所示错误的概率为 90%以上。 

解决方法一： 

根据错误提示点“是(Y)”，去寻找“Bridge”，在弹出的文件浏览器页面选择“Bridge”的上

层目录“Desktop”，然后点“确定”即可，如图 015-4。 

 

图 015-4 手动寻找外部子系统 
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解决方法二： 

将“Bridge”模型（整个文件夹）放置在“车桥耦合”模型文件夹里面，如图 015-5。 

 

图 015-5 自动寻找子系统 

如此，每当 UM 程序加载这个“车桥耦合”模型时，它就会自动在其模型文件夹里搜寻

所有被调用的外部子系统。 

注：以外部子系统方式导入车辆等多刚体模型时，也需要如此操作。切勿直接将

input.dat，input.fss 文件直接放入最终模型文件夹里。 
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016. 如何在绘图窗口设置坐标轴标签？ 

UM Simulation 里的绘图窗口默认没有坐标轴标签，如果懒得用专业软件去处理绘图，

那么可以直接在 UM 做一些设置得到预期的效果。 

下面我们以某车桥耦合计算得到的桥梁竖向位移为例，向大家介绍基本操作方法，如

图 016-1。 

 

图 016-1 修改前后效果对比 

1、添加横（纵）坐标轴标签 

默认横、纵坐标标签为空。在绘图窗口右键，选择 options...，选择 Axes，选择 Legend，

在 X-values 右侧添加横轴标签，在 Ordinate 右侧添加纵轴标签，点击 OK，如图 016-2； 

 

图 016-2 添加横、纵坐标标签 
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2、纵（横）坐标显示单位设置 

UM 计算结果默认为国际单位，位移对应则为米，而桥梁位移一般在毫米数量级，因

此需要修改。 

在绘图窗口点右键，选择 Axes，选择 Style，取消 Show scale factors 勾选，再选择

Marking，在 Scale for Y 右侧填写-3（-3 表示显示刻度为原来的 10e-3 倍），点击 OK，如

图 016-3； 

 

图 016-3 设置显示刻度 

3、设置字体大小 

（1）标签字体：默认字体为 8 号，绘图窗口右键，选择 Options，选择 Axes，再选择

Legend，将 Font size 右侧修改为 15，取消 Legend on plot 勾选； 

（2）刻度字体：默认字体为 7 号，绘图窗口右键，选择 Options，选择 Design，再选

择 General，将 Font size 右侧修改为 15，如图 016-4； 
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图 016-4 设置显示字体大小 

4、上（下、左、右）边框设置 

绘图窗口右键，选择 Design，再选择 Offset，在 On screen 中，将 from bottom 修改

为 40 points，将 from left 修改为 60 points，如图 016-5。 

 

图 016-5 设置边框宽度 

修改后最终效果如图 016-6。 

 

图 016-6 最终效果 

此外，颜色、线框（条）宽度等均可修改，可根据需要自由选择。 
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017. 如何输出磨耗仿真每次型面更新对应的车数或公里数？ 

我们知道，使用 UM 软件（模块配置：UM Base+UM Loco+UM Experiments+UM 

Rail/Wheel Wear）可进行轮轨磨耗仿真。 

如果磨车轮，每次型面更新对应一定的公里数；如果磨钢轨，则对应一定的车数。 

那么如何批量输出这些公里数或车数呢？（注：本例不适用 UM8.5 及以后版本） 

下面我们以某钢轨磨耗为例介绍方法，如图 017-1，红色框内数字（左列对应单次磨

耗，右列对应累计磨耗）表示这段钢轨上通过的车数。 

 

图 017-1 磨耗计算结果 

1、全选所有型面（Variables），右键，选择 Save to file...，保存为.txt 的文本文件，如

图 017-2； 

 

图 017-2 保存的型面数据 

2、用记事本打开，并删除所有型面数据，仅保留变量名称，如图 017-3； 
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图 017-3 删除型面数据 

3、选择文本文件的编辑-替换，将“(”“：”“)”全部替换为空，如图 017-4； 

 

图 017-4 选择替换 

最终效果如图 017-5，保存该文本文件； 
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图 017-5 替换后的文本文件 

4、新建一个 Excel 表格，选择文件-打开（或：数据-自文本），导入文本，如图 017-6； 

 

图 017-6 用 excel 打开文本文件 
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5、在文本导入向导第 1 步中选择“分隔符号”，点击“下一步”，如图 017-7； 

 

图 017-7 文本导入向导步骤 1 

6、在文本导入向导第 2 步中选择勾选“逗号”“空格”，点击下一步，如图 017-8； 

 

图 017-8 文本导入向导步骤 2 
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7、在文本导入向导第 3 步中，选择“完成”，如图 017-9； 

 

图 017-9 文本导入向导步骤 3 

8、在 Excel 表格第 F 和 G 列就是我们需要的车数，其中 F 列为当前型面更新时走过

的车数，G 列为总计车数，如图 017-10。 

 

图 017-10 导入 Excel 后 

其他不需要的列（行），删除即可。 
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018. 如何借用其他模型的几何图形？ 

我们常常看到其他模型上有非常漂亮的几何图形，如车体、转向架、电机等等，那么

如何让这些几何图形为我所用呢？ 

下面我们以 UM 软件自带的 TGV（韩国 KTX）车体为例，介绍“借用之法”。 

1、运行 UM Input，打开 Samples 里的 TGV_KTX 模型，进入 PowerCar1 子系统，

如图 018-1。 

 

图 018-1 GTV 头车子系统 

2、在左侧模型树展开 Images，选中 Carbody 几何图形，如图 018-2； 

 

图 018-2 选择几何图形 

3、选择菜单 Edit-Copy to file...，点保存，如图 018-3； 
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图 018-3 保存为 img 文件 

4、新建或者打开一个模型，选择菜单 Edit-Read from file...，选择上一步保存的

Carbody.img 文件，点打开，如图 018-4； 

 

图 018-4 导入 img 文件 

可以看到，TGV 车体几何图形已成功导入到自己模型中。 

注：如果几何图形采用了参数化建模，那么这些参数（标识符）及数值也会一并导入。 
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019. 如何将一个模型转换为子系统？ 

无论是 CAE 工程师，还是程序员，都喜欢将分析对象进行模块化处理。UM 软件具有

强大的子系统建模技术，支持子系统的自动转换、多次复制和多层嵌套，能大大减少用户

建模工作。 

以某动车转向架为例，介绍如何转换生成子系统，以及再次编辑子系统，如图 019-1。 

 

图 019-1 某动车转向架 

一、转换生成子系统： 

1、当一个转向架全部建完之后，在左侧模型树选择 Object，在右侧选择 General，点

击 Transform into subsystem，如图 019-2； 

 

图 019-2 一键转换子系统 
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2、在弹出的对话框中点击“确定”如图 019-3； 

 

图 019-3 确定转换模型为子系统 

3、此时模型已成功转换为一个独立的子系统，我们可以对其整体操控，如图 019-4，

在左侧模型树中只剩一个子系统，而看不到 Body、Joint 和 Force； 

 

图 019-4 已成为子系统 

二、再次编辑子系统： 

1、若需要对该子系统进行再次编辑修改，可在左侧选中该子系统，在右侧选择 Edit 

subsystem，如图 019-4； 

2、进入该子系统进行修改（模型树中所有的 Body、Joint 和 Force 可见可编辑），如图

019-5；  
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图 019-5 再次进行子系统编辑 

3、修改完成之后，点击右上角 Close subsystem 中的 Accept，这样子系统将自动保存

对子系统修改后的结果，如图 019-6。 

 

图 019-6 接受修改结果 

4、一定记得边做边保存模型哦！ 

注：该子系统可进行复制、移动等操作。 

  



                                                    

第 60 页 
 

020. 如何正确选择铁道车辆仿真的速度模式？ 

对于铁道车辆或列车动力学仿真，必须指定正确的速度模式。 

UM 提供以下四种速度模式，如图 020-1： 

 

图 020-1 速度模式 

A：Neutral  （惰行），无控制无约束 

B：v=const  （匀速），自动控制 

C：Profile  （变速），自动控制 

D：v=0 （零速），附加约束 

软件默认为惰行模式，即：初始设定 v0 为某一速度，这样车辆在轮轨蠕滑、曲线、坡

道等阻力作用下会逐渐降速；而有时候，我们需要用到匀速、变速或零速模式。 

车辆速度自动控制原理：基于反馈原理，在车体或其他部件上施加一个外力 F（沿车

辆纵向），外力计算公式如下： 

F=-k(v-v0) 

式中：v0 为目标速度（匀速模式为定值，变速模式为曲线）； 

        v 为实际速度（自控系统的输入参数）； 

        k 为控制力系数（自控系统的输出参数）。 

在时域仿真计算的每一个积分步，程序获取当前车辆的实际速度，并与目标速度相比

较，自动计算得到速度控制力，将其作用于车体，使得速度改变，如此迭代。 

下面以车辆上坡为例，对比惰行模式和匀速模式，如图 020-2。 
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图 020-2 上坡线路 

仿真速度：v0=80m/s；仿真距离：1600m；轨道不平顺：无。 

其中，匀速模式设置如图 020-3：速度控制力作用于车体(0,0,1)点，控制力系数默认为

1000000 N.s/m(可根据实际情况修改大小，以调整控制灵敏度)。 

 

图 020-3 设置匀速模式 

两种速度模式计算结果（轨道坐标系下车辆纵向速度）对比如图 020-4，蓝色（上）为

匀速，红色（下）为惰行。 
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图 020-4 计算结果对比 

变速仿真的控制原理与匀速模式一样，只是目标速度不再是常量，而是变量，即：在

每一时刻都有一个 v0 值（v0 既可以是时间的函数，也可以是距离的函数），设置如图 020-

5 和 020-6： 

 

图 020-5 设置变速模式 
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图 020-6 设置目标速度曲线 

将轨道线路设置为平直道，计算得到的车体纵向速度如图 020-7。 

 

图 020-7 计算得到的速度曲线 

注：若速度曲线初值为 0，则必须选择时间为横坐标。 
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零速模式常用于模型初始的静平衡计算，可选择给轮对加附加约束，可设定系统动能

阈值，这样程序会自动判定平衡并保存为初始条件，如图 020-8。 

 

图 020-8 零速模式 

 

图 020-9 系统平衡 
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021. 如何把数据文件导入曲线编辑器？ 

在使用UM软件进行动力学建模或仿真时，经常会用到曲线编辑器。如定义几何截面、

扫掠路径、非线性刚度、非线性阻尼、非线性力、轮轨型面、速度随时间变化的曲线、摩

擦系数沿线路变化的曲线、实测的轨道线路、超高沿轨道变化的曲线、轨距加宽沿轨道变

化的曲线、轨道刚度沿线路变化的曲线、实测的轨道不平顺等等。 

当数据点比较少时，我们可以直接在曲线编辑器里一个一个地加点，但如果点数太多，

则效率比较低，这时候就可以考虑以文件形式一次性读入。 

我们以横向止挡为例，介绍曲线编辑器如何读入文件。 

1、新建一个文本文件，输入两列曲线数据（第一列横坐标，第二列纵坐标，中间间隔

空格，单调递增），保存文件，如图 021-1； 

 

图 021-1 输入数据 

2、重命名文件，将扩展名由 txt 更改为 crv，并回车，如图 021-2； 

 

图 021-2 更改扩展名 
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3、弹出提示，点击“是”，如图 021-3； 

 

图 021-3 确定更改 

4、点击曲线编辑器的“打开”按钮（如果没显示，将绘图窗口右边界往左拉即可，如图

021-4），选择文件“横向止挡.crv”，点击打开； 

 

图 021-4 打开文件 

5、此时文件中的数据已读入曲线编辑器，点击“OK”。 

 

图 021-5 读取数据 
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022. 如何导入 STL 或 3DS 格式的 Part？ 

我们知道 UM 有非常强大的可视化功能，虽然它本身也能进行复杂的 3D 建模，但是

你可能更喜欢采用专业的三维设计软件进行 3D 建模，那么如何把这些 3D 模型导入 UM

软件呢？ 

如果你的电脑上同时装了 UM 和 Inventor，或 UG，或 Solidworks，或 Kompas-3D，那

么他们所建的模型是可以直接无缝导入 UM 的；对于 Pro/E，则需要安装我们提供的专用

接口(见群文件)进行格式转换。 

此外，我们经常使用一些通用的中间格式文件，如 STL、STEP、IGES 等。我们以常

见的 STL、3DS 格式文件为例，介绍导入之法。 

一、导入 STL 格式文件 

1、使用三维软件创建几何模型，并输出为 STL 格式文件，如图 022-1； 

 

图 022-1 三维软件输入的 STL 格式文件 

2、打开 UM Input，在菜单栏选择 Tool→Import from CAD→STL...，如图 022-2； 

 

图 022-2 打开 STL 文件导入工具 
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3、点击 CAD file converter 的 STL，选择创建的 STL 文件，点击打开，如图 022-3； 

 

图 022-3 选择 STL 格式文件 

4、根据三维软件建模时所使用的单位，在 Unit 处选择正确的单位，软件自带单位有

米、厘米、毫米、英尺、英寸；若无合适的，可选择 Custom，在 Multiplier 中自定义比例

系数，选择好之后点击 Accept，如图 022-4； 

 

图 022-4 设置单位 

5、导入之后可对其进行旋转、移动、复制等，如图 022-5。 

 

图 022-5 STL 格式文件导入 UM 
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二、3DS 格式文件导入 

1、在 UM Input 菜单栏选择 Tool→Import from CAD→3ds...，如图 022-6； 

 

图 022-6 

2、在 File 右下侧点击打开按钮，选择 3ds 文件，设置单位，点击 Save，保存为.ucf 格

式文件； 

3、在 UM Input 菜单栏选择 Tool→Import from CAD→UM CAD file...，选择上一步保

存的.ucf 格式文件，点击打开； 

4、此时 3ds 格式文件已成功导入，如图 022-7。 

 

图 022-7 3DS 文件导入 UM 
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023. 如何将导入的多个 Part 合并为一个 Body？ 

我们导入的外部几何本身是一个装配体时，导进来后又会变成一系列零件，因此需要

把多个零件合并为一个刚体。 

 

图 023-1 装配体模型 

如图 023-1 所示，飞机模型由个 9 个 Part 组成，每一个 Part 对应生成了一个 Body，如

果想要将其合并为一个 Body，操作如下： 

首先，在左侧模型树选中任一个 Body，然后在右边定位到 Part 页面，如图 023-2。 

 

图 023-2 选择 Part 

你会发现这里列出了所有的 Part，而缺省只是勾选了其中一个，通过右键菜单 Select 

all 可选择所有 Part（也可根据需要手动勾选若干个），最后点击下方的 OK 按钮，即可完
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成合并，如图 023-3。 

 

图 023-3 合并 Part 

当完成合并之后，你会发现左侧模型树只剩下一个 Body，如图 023-4。 

 

图 023-4 合并成功 
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需要说明的是，这里的合并只是将原始的 9 个 Part 几何按实际位置堆积在一起，并非

布尔运算。 

由图 023-4 可以看出，UM 的基本几何类型（GE）有一种就叫 GO，它可以引用之前

的任意几何体（GO），使用这种方法我们可以随意合并 N 多个几何体，最后赋给一个刚体

Body。 

注意：Images 中的 Part1-Part9 是各部件原始几何，不可删除。 
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024. 在 UM 里如何调用 CONTACT 计算轮轨蠕滑力 

注：本例操作不适用 UM 9.0 及以后版本。 

目前，UM Loco 模块提供了 Fastsim、Non-elliptical、Kik-Piotrowski、CONTACT 等多

种轮轨蠕滑力模型，供用户选择使用。 

然而，在 UM Simulation 的用户界面，这几种算法并不是同时出现，他们各自适用于

不同的轨道模型，而不同的轨道模型又需要从 UM Input 进行相关操作，方可激活。 

通常，我们在 UM Input 建立铁道车辆模型时，直接调用标准轮对子系统，然后修改几

何和质量惯量参数，如图 024-1 所示。 

 

图 024-1 
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在进入 UM Simulation 仿真程序后，你会发现轨道模型为“Massless rail”，另外两种轨

道模型“Inertial rail”和“Flexible track”并未激活，不可选择，如图 024-2。 

 

图 024-2 

 

“Massless rail”是连续弹性支撑的无质量轨道模型，轨道刚度可以是常数，也可以沿着

线路变化。这种轨道模型支持的蠕滑力模型如图 024-3 所示，其中最为常用的是 FASTSIM

和 Non-ellipitical，只能模拟一点和两点接触。 

 

图 024-3 

那么，如何才能使用 Kik-Piotrowski 或 CONTACT 多点接触模型呢？ 

我们必须先回到 UM Input 程序，在轮对子系统界面勾选“Inertial rail”这个选项，如图

024-4。 
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图 024-4 

 

然后再进入 UM Simulation 程序，你会发现“Inertial rail”轨道模型已被激活，如图 024-

5。 

 

图 024-5 

同时，轨道刚度和阻尼参数转移到“Identifiers”里面，如图 024-6。 



                                                    

第 76 页 
 

 

图 024-6 

再来看看蠕滑力模型，这时只有 Kik-Piotrowski 和 CONTACT 两种算法可选，如图 024-

7。 

 

图 024-7 
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需要注意的是，CONTACT 需要单独的 license 文件，如图 024-8。 

 

图 024-8 

如果是柔性轨道（需要在 UM Input 里添加一个“Flexible Railway Track”子系统），则

只能采用 Kik-Piotrowski 算法，无需用户选择，如图 024-9。 

 

图 024-9 
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025. 如何设置铁道车辆不同的初始速度？ 

在 UM Loco 模块，对于一个铁道车辆或列车模型，在仿真开始的一瞬，所有的物体都

具有同一个初始速度 v0。 

然而有时候我们需要对不同的车辆设置不同的初始速度，如：模拟车辆冲击。 

下面以一个最简单的例子说明操作方法。 

首先，准备好一个车辆模型，这里其实就是一个单轮对。 

然后，新建一个模型，添加一个子系统，这里注意必须选择“external”，将已有的车辆

模型（单轮对）以外部子系统的方式导进来，再复制生成第二个，向前移动一定距离，如

图 025-1 所示。 

 

图 025-1 

这里，我们为两个车辆子系统（单轮对）创建一个球-球接触力元，保存模型。 
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图 025-2 

现在进入仿真程序，打开仿真设置界面，定位到 Rail/Wheel-Speed 参数页面，你会发

现这里比平时多了一个选项 Equal initial speed，将其取消勾选。 

 

图 025-3 
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再定位到 Identifiers 页面，将第二个子系统里的 v0 设置为 0，同时保持第一个子系统

的 v0 不变。 

 

图 025-4 

最后，执行仿真，你会发现第一个轮对冲击第二个轮对的过程。 

 

图 025-5 

另外需注意：最好将所有外部子系统（包括柔性体）文件夹放到模型里面，否则经常

会出现找不到外部子系统的提示或错误链接到其他同名子系统。 

 

图 025-6 
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026. 新版本如何实现铁路车桥耦合仿真？ 

对于以前版本的 UM，只要一个模型里同时有轮对子系统和外部 FEM 子系统，则在

仿真界面会自动出现铁路车桥耦合（Vehicle-Bridge Interaction）功能的选项。 

自 UM 8.1.2.8 版本起，由于新增加了单轨车桥耦合功能，因此需要特别的操作加以区

分。 

对于每一个铁路桥梁子系统，我们必须在 UM Input 建模程序里添加一个备注：

@rwbridge=true@, 如图 026-1 所示。 

而对于单独导入的桥墩及其他下部结构，则不需要加任何备注，因为它们和桥梁子系

统通过铰或力元产生相互作用。 

 

图 026-1 

这样，我们在进入 UM Simulation 仿真程序后，在仿真设置界面才会出现铁路车桥耦

合的相关选项，勾选之，如图 026-2 所示。 
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图 026-2 

如果是桥梁模型采用梁单元建立，则还需要指定传力梁，勾选 Wheels interact with 

beams，并输入左右车轮传力梁的起点和终点坐标，如图 026-3 所示。注意：这里输入的坐

标是桥梁子系统的局部坐标，左右轮可指定同一根传力梁。 

 

图 026-3 

一般车桥耦合动力学仿真不计桥梁自重，因此需要取消勾选 Gravity 选项。为了不让

桥梁和车辆一样具有初始速度 v0，必须取消勾选 Set initial speed to v0，如图 026-4 所示。 
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图 026-4 

此外，还可以自定义桥梁变形的放大倍数，如图 026-5 所示。 

 

图 026-5 

 

图 026-6 
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027. 如何实现铁路车线桥（下部结构）耦合仿真？ 

在前一篇文章中，我们介绍了基于 UM VBI 模块的铁路车桥耦合仿真实现方法，其优

点在于不仅支持实体单元，还支持板壳和梁杆单元，可轻松应对大跨度和多跨桥梁。然而

其轨道模型比较简化，表现为连续弹性支撑，没有考虑钢轨和轨枕的质量与转动惯量，也

无法获得扣件系统的响应。 

基于 UM Flexible Railway Track 柔性轨道模块，我们可以实现“车-线-桥/下部结构”耦

合仿真，其操作方法有别于 UM VBI 方案。 

UM 的柔性轨道模型包含了钢轨（铁木辛柯梁）、轨枕（刚体）和扣件系统（Bushing 力

元），桥梁或轨道下部结构与柔性轨道系统之间是通过两排（左右轨）有间隔（轨枕间距）

的 Bushing 力元（指定坐标和参数，自动生成）相连。因此，我们需要准备比较精细的有

限元模型（实体或板壳单元），并设计好节点坐标（传力点），以便能和轨枕/扣件位置相对

应，如图 027-1。 

 

图 027-1 
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车辆、轨道和桥梁分别是三个子系统，这里并不需要像 UM VBI 方案那样对桥梁子系

统设置备注，如图 027-2。 

 

图 027-2 

进入仿真程序后，将轨道类型设置为 Flexible track，如图 027-3。 

 

图 027-3 

将整个轨道划分为三段，第一段是从桥头起往后方（足够长），第三段是桥尾起往前方

（足够长），中间一段对应桥梁段，在 FE foundation 处勾选“桥梁”子系统，表示这一段轨

道与桥梁相互作用，如图 027-4。 
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图 027-4 

Point1 和 Point2 表示桥上轨道中心线的起始点坐标（局部坐标），Start Point 表示桥

上第一个轨枕/扣件相对 Point1 的纵向距离，Distance between rails 表示左右轨枕/扣件横

向间距。系统会自动根据这组几何参数找到桥梁上每一个轨枕/扣件作用点，并自动生成 2N

个 Bushing 力元(刚度和阻尼参数可修改)。 

注意：轨枕间距一般是网格纵向尺寸的整数倍。 
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图 027-5 

对于柔性轨道模型，软件强制选择 Kik-Piotrowski 多点接触模型计算轮轨蠕滑力，无

他选择。由于系统自由度比较大，因此需采用 Park Parallel 并行算法进行求解，如图 027-

6。 

 

图 027-6 

如果导入了多层轨下柔性子系统，我们只需要勾选和设置最上层的子系统（直接与柔

性轨道系统作用），下层和上层结构之间通过在 UM Input 里创建的一系列（可编程批量生

成）Bushing 力元传递相互作用，如图 027-7。 
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图 027-7 

另外，记得取消每个轨下柔性子系统的重力和初始速度，如 027-8。 

 

图 027-8 

请仔细看，这里是没有 Railway Bridge 选项的，因为它属于 VBI 方案，而柔性轨道能

做的可不仅仅是车线桥耦合。 
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028. 如何生成和使用轨道随机不平顺？ 

对于铁道车辆-轨道动力学数值仿真，轨道的随机不平顺样本对计算结果影响很大。 

这里以美国 V 级谱为例，介绍 UM 软件生成和使用轨道随机不平顺的方法。 

1、运行 UM Simulation 程序，找到【Create irregularities】，弹出轨道不平顺工具界面，

如图 028-1； 

 

图 028-1 

 

图 028-2 

2、在用户界面依次选择【Spectrum】-【FRA】-【5】-【Z+】，然后设置不平顺区间

【0，3000】m，安全系数【0.25】，波长范围【1，30】m；点击【Compute】，生成高低不

平顺样本（左下方区域）；保持圆圈处 Factor 为缺省值 1，点击左边的箭头（↑），将高低不
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平顺样本按 1 倍添加到上方区域，如图 028-3。 

 

图 028-3 

3、在图 028-2 界面，直接切换选择【Z-】，然后点击【Compute】，生成水平不平顺，

分别以【+0.5】和【-0.5】倍数将水平不平顺添加到上方区域，如图 028-4。这样，勾选第

一个和第二个表示合成左轨垂向不平顺样本，勾选第一和第三个表示合成右轨垂向不平顺

样本，分别保存为*.way 文件。 
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图 028-4 

这里需要讨论一下轨道不平顺的定义和叠加方法。笔者查阅了国内外多本文献，发现

主要有两种定义，UM 与之对应如下： 

Z+：高低不平顺（Z_Left + Z_Right）/2 

Z-：水平不平顺（Z_Left - Z_Right）/2 或（Z_Left - Z_Right） 

Y+：方向不平顺（Y_Left + Y_Right）/2 

Y-：轨距不平顺（Y_Left - Y_Right）/2 或（Y_Left - Y_Right） 

那么，对应叠加方法如下： 

Z_Left=（Z+ + Z-）或（Z+ + 0.5*Z-） 

Z_Right=（Z+ - Z- ）或（Z+ - 0.5*Z- ） 

Y_Left=（Y+ + Y-）或（Y+ + 0.5*Y-） 

Y_Right=（Y+ - Y-）或（Y+ - 0.5*Y-） 
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这两种定义不同在于，水平不平顺表示的是左右轨垂向不平顺之差或其一半，轨距不

平顺表示左右轨横向不平顺之差或其一半。不管定义如何，叠加方法应该前后对应，然而

国内有的文献却将其混淆，前后不一致，自相矛盾。 

我们前面的操作实际是对应第二种定义，如果采用第一种定义，那么在图 028-4 界面，

圆圈处的数值应该设置为 1 或-1。 

4、采用同样的方法，分别生成左右轨横向的不平顺样本文件。 

5、调用轨道不平顺样本：用 UM Simulation 打开一个铁道车辆模型，点开仿真设置界

面，依次选择【Rail/Wheel】-【Track】-【Irregularities】-【Uneven】-【From file】，然

后分别选择我们刚才保存的左右轨垂向和横向不平顺文件即可，如图 028-5。 

 

图 028-5 

其实，UM 可以用更快捷的方法生成轨道不平顺样本，在图 028-3 界面，直接点击右

下角【Generate horizontal and vertical irregularities】，程序会根据第一种定义自动叠加生

成仿真所需的四个样本，在左上角窗口框选四个不平顺，从右键菜单选择【Save irregularity 

goup *.tig】，保存为一组不平顺样本，如图 028-6。 
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图 028-6 

这样，我们在使用时，可以很方便地一键调用，还可根据研究需要设置不同的系数

（Factor）调节不平顺幅值，如图 028-7。 

 

图 028-7 
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029. UM 里的 D. Ratio 是轮重减载率吗？ 

轮重减载率是铁道车辆动力学分析的一个重要指标。 

在 UM Loco 模块，有一个叫 D. Ratio 的指标，如图 029-1，我们先来看看它表示什么

含义。 

 

图 029-1 

我们打开软件自带的 AC4 模型，设置直线工况，给定一组随机不平顺样本，观察第一

轮对左右轮的 D.Ratio 指标，你会发现这个指标有正有负，中心轴还不在 x 轴（y=0），如

图 029-2。 

 

图 029-2 

这是为何？ 

我们打开帮助文档第八章第 183 页（搜索“D.Ratio”），这里有关于此指标的详细说明，

如图 029-3。 
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图 029-3 

由此可见，该指标体现的是轮轨垂向力的动力系数（动轮重-静轮重）/静轮重，而这里

的静轮重却偏偏又是模型中所有车轮的平均静轮重。 

再来看这个 AC4 二轴车模型，它的前后轮对相对车体质心纵向又不对称，如图 029-

4，也就是说前后轮对的静轮重不同。因此，出现了图 029-2 的结果。 

 

图 029-4 

那么，如何消除这个全车平均静轮重的影响呢？ 

请看图 029-4，这里可以计算出每个车轮的静轮重，并可选择作为 D. Ratio 指标计算的

静轮重，也就是对每个车轮赋予单独的 Fz0。 

 

图 029-5 
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勾选之后，再看计算的结果，如图 029-6，是不是就在 x 轴上下波动，不再漂移了。 

 

图 029-6 

但是，我们的国标《铁道车辆动力学性能评定和试验鉴定规范 GB 5599-85.pdf》关于

轮重减载率是怎么定义的呢？请看图 029-7。 

 

图 029-7 

显然，这与 UM 里的 D. Ratio 并不相同。分子是减载量（左右动轮重差的一半），分母

是左右平均轮重（左右动轮重和的一半），一个轮对对应一个指标，并且≥0。 

那么，在 UM 里如何定义标准的轮重减载率指标呢？ 

如图 029-8，首先创建左右车轮的垂向力变量。 
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图 029-8 

然后，切换到 Expression 页面，依次添加四个运算符（-，+，/，abs），分别按图 029-

9 所示将变量 Q(V)_1l 和 Q(V)_1r 拖入相应位置。 

x1 = Q(V)_1l - Q(V)_1r 

x2 = Q(V)_1l + Q(V)_1r 

x3 = x1 / x2 

x4 = abs (x3) 

最后得到的 x4 变量就是我们要的轮重减载率，这里可以给它自主命名和添加备注。 
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图 029-9 

将前面创建的轮重减载率变量拖入绘图窗口，再计算，与 D. Ratio 指标对比如图 029-

10。 

 

图 029-10 

可以看出，二者除了正负号的差异外，其幅值总体一致，局部稍有不同。 

现在我们来考虑一种特殊工况，假设不计轨道不平顺，设置轨道垂向刚度（左右轨同

步）沿着线路方向有变化，如图 029-11。 
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图 029-11 

通过计算，你会发现，轮重减载率几乎始终为 0，如图 029-12。因为左右车轮同升同

降，不存在一侧增载另一侧减载。而对于每个车轮，其轮轨力在波动，即存在动态冲击，

D. Ratio 实际就体现的是这个冲击。 

 

图 029-12 

上述对比也可以通过给左右轨施加同一个垂向不平顺样本（不计横向）的工况来实现，

区别更大。 
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030. 如何将 ANSYS 模型导入 UM 软件？ 

一、准备工作（只需一次） 

1、在安装好 UM 软件后，到安装目录找到文件 um.mac。 

 

图 030-1 

2、选中，右键，用记事本打开文件 um.mac，将垂直滑动条拖到底。 

 

图 030-2 
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3、将红框中的路径替换为当前文件的路径（实际就是接口程序 ANSYS_UM.exe 的路

径），并保存。（如果提示没有权限，可将文件复制到其他位置，修改并保存） 

 

图 030-3 

4、将修改后的文件 um.mac 复制到 ANSYS 软件的 apdl 文件夹里。 

 

图 030-4 
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二、ANSYS 建模与计算 

1、在 UM 的数据路径（注意不是安装路径），找到学习例子 PlatformShell63Demo.ans。 

 

图 030-5 

 

图 030-6 

2、用记事本打开，如下图，红框里的命令流表示选择编号为 5、11、105 和 111 的关

键点对应的节点为界面节点（也可以根据节点号直接选择节点），调用 um.mac 宏命令进行

模态计算，截断阶数为（10），质量矩阵为集中质量阵（1）。 

 

图 030-7 
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3、运行 ANSYS，设置好工作目录，选择菜单 File→Read input from...，找到文件

PlatformShell63Demo.ans，点 OK，自动开始建模和计算。 

 

图 030-8 

三、ANSYS_UM 文件转换 

1、待 ANSYS 计算完毕，会自动弹出 ANSYS_UM.exe 转换程序界面（这也是前面修

改 um.mac 里路径的目的；如未修改或路径有误，则需要到 UM 安装目录找到文件

ANSYS_UM.exe，双击运行即可；实际上 ANSYS_UM.exe 是可以独立于 UM 而运行的）。 

2、在 File 页面选择结果文件 Platform.rst，然后勾选 Save to the same directory，保

存到同一目录。 

 

图 030-9 
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3、切换到 Options 页面，勾选 Normalize modes 和 Exclude rigid body modes，设置

截断频率 0.3（此处认为低于 0.3Hz 的为刚体模态，可修改），点击 OK，进行模态正交化

并剔除刚体模态。 

 

图 030-10 

4、弹出提示，点击 OK。 

 

图 030-11 

5、弹出提示，点击 OK。 
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图 030-12 

6、这样就生成了 UM 所需要的文件 input.fss。 

 

图 030-13 

四、导入 UM 

1、运行 UM Input 程序。 

2、选中左侧模型树 Subsytems，右侧点击加号图标，添加一个子系统。 

3、从 Type 下拉菜单中选择 Linear FEM Subsystem，将刚才创建的 Platform 读入（注

意所有的弹性体都是 input.fss，UM 识别的是其所在文件夹的名称）。 

 

图 030-14 
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031. 如何将 ABAQUS 模型导入 UM 软件？ 

本例使用 ABAQUS 6.12-1 版本。 

1、从 QQ 群下载文件 ABAQUS.rar，解压到本地；运行 ABAQUS，打开示例模型

ABAQUS.cae，如图 031-1。 

 

图 031-1 

2、创建第一个分析步，选择 Linear perturbation- Frequency。 

 

图 031-2 
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3、点击 Continue，设置模态阶数：20。 

 

图 031-3 

4、切换到 Other 页面，选择 Mass，然后点击 OK。 

 

图 031-4 

5、设置边界条件，选择 Mechanical-Displacement/Rotation。 

 

图 031-5 
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6、点击 Continue，提示要选择目标区域。 

 

图 031-6 

7、点击 Sets，从集合列表中选择 Part-1-1.IN，该节点集包含四个端面的主节点（每个

端面所有节点的自由度与相应主节点的自由度耦合，即：局部刚化）。 

 

图 031-7 

8、点击 Continue，勾选三个平动和三个转动自由度（对于实体模型，如果没有创建

Mass 点做局部刚化，而直接用实体单元的节点作为主节点，那么此处只勾选三个平动自由

度）。 

 

图 031-8 
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9、点击 OK，切换到线框视图，可以看到四个端面的约束如下图，这四个端面也正是

要在 UM 里面要创建铰或力元的地方。 

 

图 031-9 

10、创建第二个分析步，选择 Linear perturbation-Substructure generation。 

 

图 031-10  
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11、设置如下： 

 

图 031-11 

12、切换到 Options 页面，勾选如图 031-12，并设置模态区间及增量【1，20，1】。 

 

图 031-12 
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13、设置边界条件，选择 Mechanical-Retained nodal dofs。 

 

图 031-13 

14、选择节点集 Part-1-1.IN。 

 

图 031-14 

15、勾选三个平动和三个转动自由度。 

 

图 031-15  
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16、创建一个仿真任务，数据来源选择 Model。 

 

图 031-16 

17、打开任务编辑器，点击 Write Input，生成 Job-1.inp 文件。 

 

图 031-17 

18、用记事本打开 Job-1.inp 文件，在第一个分析步最后一行的前面写入三行数据： 

*ELEMENT MATRIX OUTPUT, MASS=YES, ELSET=Part-1-1_All 

*NODE FILE 

U 

 

图 031-18 

19、在第二个分析步最后一行的前面写入一行数据： 

*SUBSTRUCTURE MATRIX OUTPUT, STIFFNESS=YES, MASS=YES, 

RECOVERY=YES 
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图 031-19 

 

20、保存修改，重命名为 ABAQUS.inp。 

21、创建新的仿真任务，选择数据来源 Input file，加载 ABAQUS.inp，点击 Continue。 

 

图 031-20 

 

22、可以先检查数据 Data Check，再提交任务 Submit。 

 

图 031-21 

23、待计算完毕，运行 UM 安装目录下的 ABAQUS_UM_XE8.exe，读取 ABAQUS 结

果文件 ABAQUS.fil，勾选 Save to the same directory，自定义名字和备注，点击 Create。 
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图 031-22 

24、弹出如下界面，完成转换，生成 input.fum 文件，这个文件还需进一步转换为

input.fss 文件。 

 

图 031-23 

25、运行 UM Input 程序，选择菜单 Tools-Wizard of flexible subsystems，并读入

input.fum 文件。 
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图 031-24 

26、切换到 Solution 界面，这里可以观察每一阶模态的振型。 

27、勾选 Save to the same directory，勾选 Exclude rigid body modes，设置截止频率

0.3Hz，然后点击 Transform。 

 

图 031-25 
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28、弹出如下提示，依次点击 OK，OK。 

 

 

图 031-26 

29、依次点击 Save as，Save，OK，保存 input.fss 文件，然后关闭 Wizard of flexible 

subsytems。 

 

 

图 031-27 

30、新建一个 UM 模型，添加一个子系统，选择 Linear FEM subsystem，读入模型

ABAQUS（文件夹名字）。 
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032. 如何输出轨道不平顺样本数据？ 

方法一： 

1、运行 UM Simulation 程序。 

2、选择菜单 Tools→Graphic window，打开一个绘图窗口。 

 

图 032-1 

3、在绘图窗口左侧列表区点右键，选择菜单 Load from file。 

 

图 032-2 
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4、弹出文件浏览器，定位到不平顺文件存放的路径，选择文件格式*.way（默认为*.txt）。 

 

图 032-3 

5、选中某一不平顺文件，点击打开，加载到绘图窗口。 

 

图 032-4 

6、在绘图窗口左侧选中这条曲线，点右键，选择相应的菜单可输出至 Excel 或 TXT。 

 

图 032-5 
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方法二： 

1、运行 UM Simulation 程序 

2、选择菜单 File→Open，打开某一个车辆模型。 

3、设置轨道不平顺类型为 Uneven，然后加载不平顺样本。 

 

图 032-6 

4、点击工具栏图标 Show irregularities 显示不平顺。 

 

图 032-7 

5、在不平顺窗口选中某一样本，点右键，选择相应的菜单可输出至 Excel 或 TXT。 

 

图 032-8 
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033. 解决 UM Input 或 UM Simulation 程序不能正常运行的方法 

问题描述：最近有个别用户在运行 UM Input 或 UM Simulation 时遇到程序停止工作的

问题，如图 033-1。 

 

图 033-1 

问题原因：这是由于用户安装的其他软件（特别是某些国产杀毒软件）对当前用户的

帐户配置做了一些未知修改，导致与 UM 软件发生冲突。 

解决办法：以前遇到此问题的用户一般采取“重装系统”的方式来彻底解决，现在我们

提供一个更简单方便的方法。 

1、打开 Windows 系统的“控制面板”，找到“用户帐户”或“用户帐户和家庭安全”，如图

033-2。 

 

图 033-2 

2、选择“用户帐户”里的“添加或删除用户帐户”或“管理其他帐户”，如图 033-3。 
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图 033-3 

3、选择“创建一个新帐户”或“在电脑设置中添加新用户”，如图 033-4。 

 

图 033-4 

4、输入一个新用户名，并点击“创建帐户”，如图 33-5、33-6。温馨提示：如果要在新

的用户帐户下安装软件，在图 033-5 中最好选择“管理员”身份，以保证足够的权限。 

 

图 033-5 
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图 033-6 

5、现在，切换到新创建的用户帐户，如图 033-7 和图 033-8。 

 

图 033-7 

 

图 033-8 

6、使用新的用户帐户进入系统后，找到 UM 软件安装路径下 umiput.exe 以及

umsimul.exe（不必重新安装软件），双击即可正常运行，如图 033-9。用户可通过右键菜单

创建桌面快捷方式，以便后续使用。 
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图 033-9 

7、UM Input 程序正常运行的界面，如图 033-10。 

 

图 033-10 
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034. UM 参数化建模定义表达式的正确操作 

问题描述：不少初学者在练习《UM 培训教程》里的“多刚体车辆模型”时，容易遇到

一个错误，如图 034-1。 

 

图 034-1 

问题原因：这是由于 fz1 的表达式引用的参数符号 mcarbody 和 mframe 位于其下方，

而这并不符合的基本的编程逻辑。 

解决办法：先将参数符号 mcarbody 和 mframe 拖动移到 fz1 的上方，再定义 fz1 的表

达式。 
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一般来说，严格按照教程操作是不会遇到此问题的。 

 

图 034-2 

请注意：此处不能输入表达式（Expression），只能输入数值（Value），保持缺省为 0 即

可。 

 

图 034-3 
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双击 fz1，定义参数化的表达式： 

 

 

图 034-4 

表达式新定义的参数符号自动位于 fz1 之前。 

 

图 034-5 
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035. UM 模型复制参数符号列表的方法 

本文介绍使用 UM 软件将一个模型的参数符号列表复制到另一个模型的方法，举例说

明如下： 

1、打开 UM 软件自带的 AC4 二轴车辆模型，点击左侧下方参数符号列表的保存按钮。 

 

图 035-1 

2、从弹出菜单选择 Local list。 

 

图 035-2 

3、自定义名称，将 par 格式文件保存到本地。 
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图 035-3 

4、新建一个 UM 模型，点击左侧下方参数符号列表的打开按钮，选择之前保存的 par

文件，读入参数符号列表。 

 

 

图 035-4 

此外，用户也可以使用记事本等文本编辑器打开AC4模型文件夹下的 input.dat文件，

找到 with const 字段，将其复制，然后粘贴到目标模型的 input.dat 文件里相应位置，保存

即可。 
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图 035-5 
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036. 为什么笔记本配置明明很高，运行 UM Input 却很卡顿？ 

问题描述：常有用户反映，使用 UM Input 程序打开一些稍微复杂模型时动画窗口就无

法正常显示或十分卡顿，如图 036-1 所示，然而发现其笔记本电脑各项配置并不低。 

 

图 036-1 

问题原因：这是由于许多笔记本电脑配有双显卡，而缺省使用的是性能较低的集成显

卡，导致独立显卡的高性能没法发挥。解决方法：在独立显卡控制面板将首选图形处理器

换为高性能处理器即可。以 NVIDIA 显卡为例，具体操作如下： 

1、在桌面空白处点右键，选择菜单 NVIDIA 控制面板。 

 

图 036-2 
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2、在 NVIDIA 控制面板左侧选择管理 3D 设置。 

 

图 036-3 

3、在右侧点击程序设置，选择要自定义的程序 UM Input，点击添加，并设置高性能

NVIDIA 处理器为首选图形处理器，最后点应用即可。 

 

图 036-4 
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037. 详解 UM 软件设置轨距的方法 

问题描述：很多铁路行业的初学者都有这样一个疑问，UM 软件无论是在建模还是仿

真界面都没有直接定义轨距的地方，那么软件是如何确定轨距的呢？ 

方法介绍：1、我们在 UM Input 程序中添加参数化的轮对子系统时，需要定义名义滚

动圆横向跨距之半和名义滚动圆半径等参数值。 

 

图 037-1 

2、这些参数在软件界面设置如图 037-2 所示。本文以名义滚动圆半径 0.43m、名义滚

动圆横向跨距之半 0.7465m (1493mm/2)为例。 

 

图 037-2 
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3、在图 037-3 和图 037-4 中，分别标记出了轮轨型面局部坐标系的原点，车轮型面原

点一般位于名义滚动圆处，钢轨型面原点一般位于轨顶。 

 

图 037-3 

 

图 037-4 

4、如图 037-5 所示，当进行轮轨匹配时，若轮对固定，只要给轮轨型面局部坐标系原

点间距设置一定的 δ 值（想象用你的双手移动两股钢轨去和轮对匹配），就能保证满足相关

标准的轨距。很明显，这里存在一个关系式 。 
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图 037-5 

5、以中国 60kg/m 钢轨为例，考虑轨底坡 α=1:40=0.025rad 时（可在轮轨型面编辑器中

将钢轨型面旋转-1.43°得到），可测得轨距测量点 h0=16mm 处（从最高点往下量）对应的

Δ≈35.05mm (如图 037-6)。已知车轮名义滚动圆横向跨距之半 l0=0.7465m=746.5mm，轨距

之半 l1=1435/2 mm=717.5 mm，代入式 可得 δ=6.05 mm。 

 

图 037-6 
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6、因此，我们应当在 UM Simulation 仿真界面设置轨底坡 α=0.025rad，SCR-SCW 

distance（δ ）=6.05mm，如图 037-7 所示。 

 

图 037-7 

7、此外，UM 软件还提供了专门的轨距变量，可帮助用户验证轨距参数设置的正确性，

如图 037-8 所示，并在图 037-9 页面指定轨距测量高度（缺省为 14mm）。 

 

图 037-8 

 

图 037-9 
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8、如果我们设置轨底坡为 0.025rad，SCR-SCW distance(δ)值为缺省的 3.0mm，进行时

域计算，可得轨距为 1.4289m，明显不符合标准。 

 

 

 

图 037-10 

 

图 037-11 

9、中断仿真，将 SCR-SCW distance(δ)值修改为 6.05mm，再次进行时域计算，此时轨

距为 1.435m，如图 037-12。 

 

图 037-12 

10、读者可以使用上述方法计算一下中国 75kg/m 钢轨对应的 SCR-SCW distance 值为

多少。注：已知轨距 1435mm，轨底坡 1:40，轨距测量高度 16mm，名义滚动圆跨距 1493mm。 
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038. UM 软件公路车桥耦合仿真技巧：多个车道、不同车速、对

向行驶 

UM 软件发布了代号为 8363 的补丁程序，该补丁增强了 UM 8.0 系列版本单轨及公路

车桥耦合动力计算功能。比如，大家比较关心的多个车道、不同车速、对向行驶等工况，

现在 UM 都可以轻松实现。 

下面为大家介绍其中关键之处： 

1、 新建模型，导入一个公路桥梁柔性体，并设置备注：@monorail=true@，便于仿

真程序识别桥梁。 

 

图 038-1 

2、定义支座约束，如：采用 bushing 力元，在各自约束方向设置恰当的刚度和阻尼

（注：可导入多跨梁以及多个桥墩）。 

 

图 038-2 

http://mp.weixin.qq.com/s?__biz=MzIzNDIyOTMwNw==&mid=2247487289&idx=1&sn=6c7707d11e3b43be3f4b0ae7d917d142&chksm=e8f8d46ddf8f5d7b62b66a9e539dcc4c55316621a7468a9b9f4787b3e077f4fe7aeaa8c96f95&scene=21#wechat_redirect
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3、以外部子系统（External Subsystem）形式导入一个车辆模型。 

 

图 038-3 

4、设置车辆子系统的初始位置（右侧车道）。 

 

图 038-4 

、 

5、复制生成第二个车辆子系统，并修改其初始位置（位于 1 车后方）。 

 

图 038-5 
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6、复制生成第三个车辆子系统，并修改其初始位置（左侧车道，对向）。 

 

图 038-6 

7、完成建模工作，保存模型，如图 038-7 所示。 

 

图 038-7 

8、进入仿真程序，设置好轮胎、路面不平度等参数后，到 FE subsystems | Simulation 

| Monorail track | General 页面，勾选 Subsystem is monorail track 选项，启用车桥耦合功

能。 
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图 038-8 

9. 切换到 Monorail train | Speed 页面，选择 Neutral（惰行）模式，这时其上方出现

Equal initial speed 选项，将其取消（缺省勾选表示所有车辆具有相同的初始速度）。 

 

图 038-9 

10、再到 Identifiers 页面，可以单独设置每个车辆子系统的初始速度 v0，如图 038-10

所示（列表中选中的表示要一起更改，未选中的则保持不变）。 



                                                    

第 141 页 
 

 

图 038-10 

温馨提示：为保证模型计算的正确性和可移动性，请务必将桥梁子系统和车辆子系统

以文件夹形式放置于模型下，如图 038-11 所示： 

 

图 038-11 

 



                                                    

第 142 页 
 

039. UM8.5 版本录制动画失败的解决办法 

问题描述：有用户反映，在使用 UM8.5 系列版本录制仿真动画时，经常遇到严重错误，

如下图所示： 

 

图 039-1 

问题原因：这是由于 8.5 系列的软件采用了全新的图形引擎，该引擎暂时还不兼容非

ASCII 码，如中文字符，而国内用户的模型大都采用中文命名。解决办法：将模型名称以

英文字符重命名，保证模型路径和动画名称不包含非 ASCII 字符，如图 039-2，就能顺利

地完成动画录制。 

 

图 039-2 
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UM 软件录制的动画为 AVI 格式，如不能正常播放，可安装 K-Lite Codec Pack 解码

器，并建议使用其播放器进行播放。如果觉得文件过大，可采用 Camtasia Studio 等专业工

具进行压缩，并转换为 MP4 或 GIF 等格式。 

 

图 039-3 
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040. UM9.0 调用轮轨多点接触算法的方法 

UM9.0 系列版本提供的铁路轨道模型有三种，其中第二种轨道模型的使用方法与

UM8.0 略有不同，本文特作介绍。 

第一种是无质量轨道模型，不考虑钢轨的质量和转动惯量，定义轨道垂向和横向的总

体刚度和阻尼（连续弹性支撑，可沿着线路变化）。该模型只支持单点和两点接触，有效频

率一般不超过 20Hz，多用于常规的铁道车辆动力学仿真计算，如：安全性、平稳性和舒适

度等。 

 

图 040-1 

第二种是移动刚体轨道模型，在第一种模型基础上，增加了左右钢轨及轨枕刚体模型

（单层或双层），其始终跟随车轮，具有等效质量和转动惯量，钢轨和轨枕之间、轨枕与大

地之间分别采用弹簧阻尼相连，组成一个多自由度振动系统。该模型支持多点接触，有效

频率可扩展至 100Hz，适用于车辆通过道岔、脱轨分析、共形接触和轮轨型面磨耗等仿真。 

 

图 040-2 
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第三种是更加精细和接近实际的柔性轨道模型（离散支撑），其左右钢轨为参数化的

3D 铁木辛柯梁模型（可退化为欧拉梁模型），采用有限元方法（非模态叠加法或模态综合

法）建立动力学方程。该模型有效频率超过 1000Hz，适用于车辆-轨道耦合动力学仿真，

它还支持导入下部结构的弹性体（模态综合法），进行车辆-轨道-桥梁/隧道/上盖物业等大

系统耦合计算。 

 

图 040-3 

 

图 040-4 

一般来说，我们建立一个铁道车辆模型后，进入仿真程序，在缺省状态，只有第一种

轨道模型可用。 

 

图 040-5 
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图 040-6 

如何才能使用第二种轨道模型呢？请先关闭仿真程序，再用 UM Input 建模程序打开

车辆模型。在模型树左侧定位到 Object，右侧交互面板 General 页面会有个选项 Railway 

track template，缺省为 Massless，即无质量轨道模型。其下拉菜单中还有另外两种模型

Simple rigid rails 和 Rails with sleeper，这两种实际都对应前述第二种轨道模型

（Moving rigid body track），前者是单层结构（无轨枕），后者是双层结构（有轨枕）。现

在，请选择 Simple rigid rails 或 Rails with sleeper，然后保存模型。 

 

图 040-7 
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保存之后，再进入任意转向架子系统，到任意轮对页面，这里会显示 Inertial rail 选项

已被勾选。注意：切勿手动点击该选项，否则会报错，在 UM9 版本中它本应该是隐藏的。 

 

图 040-8 

退出子系统，关闭 UM Input 程序，运行 UM Simulation 程序，打开修改后的车辆模

型，此时显示移动刚体轨道模型可以选用，在弹出窗口选择 Kik-Piotrowski 模型即可（注：

CONTACT 则需要单独申请/购买许可证）。 

 

图 040-9 

 

图 040-10 
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对于第三种模型，则只需在UM Input建模时添加一个标准的柔性轨道子系统（Flexible 

Railway Track），那么进入 UM Simulation 后就能选用，操作非常简便（注：使用柔性轨

道模型时只支持 Kik-Piotrowski 多点接触算法，无需用户选择）。 

 

图 040-11 

 

图 040-12  
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041. UM Loco 输入短波不平顺的方法 

对于常规的铁道车辆动力学仿真计算，一般考虑的轨道激励是中长波不平顺。比如，

在 UM 软件里，利用不平顺工具制作不平顺样本时，其步长限定为 0.1m，用户不可更改。 

 

图 041-1 

有时候为了研究需要，如果想考虑波长更短的轨道不平顺，又该如何呢？UM Loco 模

块提供了一个 Identifiers 模式，可轻松实现。请用 UM Simulation 打开任意一个车辆或轮

对模型，在仿真控制界面，将不平顺类型切换为 Identifiers，会出现如图 041-2 的提示。 

 

图 041-2 

现在，请先关闭仿真程序，用 UM Input 程序打开模型，这里以单轮对为例说明。在

左侧参数列表，点击右键，选择最下一行的菜单 Add identifiers for irregularities。随即，

4 个新的参数符号就自动添加到列表里，分别用于定义左、右车轮的垂向和横向不平顺，
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也就是说，这些不平顺变量将始终跟随车轮。如果是一个四轴车辆模型，显然，会自动生

成 16 个参数符号。 

 

 

图 041-3 

先将模型保存，关闭 UM Input，再用仿真程序打开，此时选择 Identifiers 就不会提示

错误，如图 041-4。 

 

图 041-4 
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切换到 Identifiers | Identifiers control 页面，点击 + 按钮，弹出如图 041-5 所示界面。 

 

图 041-5 

从 Identifier 下拉菜单选择符号 irrZ_left_1，定义左轮垂向不平顺。 

 

图 041-6 
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在 Ordinate 参数框选择 Points，点击按钮 ···，弹出曲线编辑器，这里可以定义变化的

不平顺。 

 

图 041-7 

曲线编辑器可以一个一个点输入，也可以读入文件，最好提前在记事本里准备好两列

数据，并保存为 crv 格式，如图 041-8。 

 

图 041-8 
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从曲线编辑器工具栏的打开按钮就可以读入包含两列数据的 crv 文件。 

 

图 041-9 

接着，先在 Abscissa 参数框选择横坐标为 Variable，再打开变量向导，到 Wheelsets

页面，创建轮对 1 的位置变量（Position1），然后拖入 Variable 作为横坐标。这样就表示前

面定义的两列数据，其第一列是轮对在轨道上的纵向位置，第二列表示左侧车轮在对应位

置处的垂向不平顺值。 

 

图 041-10 

完成这些设置后，请点击 Accept。 
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请用同样的方法，定义右轮垂向不平顺 irrZ_right_1。 

 

图 041-11 

打开变量向导，定义轮轨垂向力变量，并在绘图窗口显示。 

 

图 041-12 

设置好合适的运行速度和采样步长，进行计算，结果如图 041-13。 

 

图 041-13 
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042. UM Monorail 模拟单轨梁缝冲击的方法 

此前，有用户提出了一个模拟单轨梁缝对跨座式车辆的冲击的需求，现在我们使用

UM9.0 系列软件已经可以实现。需注意，由于常规的路面不平度/轨道不平顺有 0.1m 点距

的限制，以及强制的光滑处理，因此不适合模拟像梁缝、错台这类特殊的冲击。在 UM9.0

的汽车和单轨模块，增加了“轮胎-地面/轨道梁”多点接触算法（注：多点指的是沿着轮胎圆

周方向允许有超过 1 个接触点）。 

 

图 042-1 

 

图 042-2 
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我们使用 UM Monorail 模块时，具体操作如下： 

1、运行仿真程序，加载一个单轨车辆模型，点开仿真控制界面，定位到 Monorail train 

| Tools，从下拉菜单选择 Special track deviations。 

 

图 042-3 

2、点击图标 ···，弹出曲线编辑器。 

 

图 042-4 
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3、在曲线编辑器定义特殊的激励，如图 042-5，其第一列表示距离（m），即梁上的位

置。 

 

图 042-5 

4、设置好后，请保存为 trp 文件。 

 

图 042-6 
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5、转到 Monorail train | Geometry, irregularities 页面，按下图所示加载 trp 文件，并

保持 Use special track deviations 为勾选状态。为便于观测冲击效果，此处我们特意取消了

轨道不平顺 Use irregularities。 

 

图 042-7 

6、按上述操作设置好特殊激励后，在动画窗口轨道梁上也会有相应的显示。 

 

图 042-8  



                                                    

第 159 页 
 

7、转到 Monorail train | Options and parameters 页面，选择多点接触模型 Multipoint，

并保持 Distributed flexible contact 为勾选状态。 

 

图 042-9 

8、执行计算，观察垂向力时程曲线，会出现如下的冲击。 

 

图 042-10 

注：此类特殊激励只对走行轮有效，对导向轮和稳定轮暂不起作用。 

  



                                                    

第 160 页 
 

043. 如何输出轨道线路随着里程的高程坐标？ 

有用户提出了这样一个问题：UM Macrogeometry 中生成的线路线形，可以导出每个

里程点的坐标吗？笔者在用户界面找了半天，确实没发现有直接输出的选项。 

 

图 043-1 

接着，尝试用记事本打开线路文件，发现它也不是坐标点的形式，而是一段一段参数

化的格式。 

 

图 043-2 
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最后，发现在用户界面可以查看平面曲线和纵断面曲线的一阶导数。 

 

图 043-3 

幸运的是，这个一阶导数是可以输出为文本格式的，右键-Save to file。 

 

图 043-4 
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输出到本地文件后，用记事本打开，把前面几行备注删除，并保存为 crv 格式，以备

用。 

 

图 043-5 

有了曲线的一阶导数，这下就好办了，可以通过积分获得曲线坐标，这里我们就以 UM

软件为例说明。新建一个模型，任意选择一个几何，创建一个刚体（自动计算质量和转动

惯量），定义一个平动铰，这里自由度给的是 X 方向（其实任意都行）。 

 

图 043-6 

在平动铰的 Description 页面勾选 Prescribed function of time，选择 Curve 类型，勾

选 Curve describes velocity，点开曲线编辑器，读入刚才保存的 crv 文件。 

 

图 043-7 
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如此，我们就定义了以某一速度曲线驱动的一个刚体的运动。 

保存模型，关闭 UM Input 后，进入 UM Simulation 仿真程序，打开它。打开变量向导，

定义刚体沿着 X 方向（与建模时的自由度方向对应）的速度和位移变量。 

 

图 043-8 

在求解器页面，设置好仿真时间（实际对应线路长度）和采样步长，就可以开始计算

了。计算结果如图 043-9： 

 

图 043-9 
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044. 车辆通过曲线时如何获得随时间变化的曲率？ 

使用 UM 软件仿真车辆通过曲线工况时，怎么才能实时获得车辆所在位置对应的曲率

或曲率半径？ 

目前在变量向导里确实没有这两个变量，不过，结合我们之前发布的两篇微文《如何

输出轨道线路随着里程的高程坐标？》和《UM Loco 输入短波不平顺的方法》，这个实现

起来并不难。具体操作如下： 

1、定义一条曲线线路，查看沿着里程的曲率（Curvature）或曲率半径（Curvature 

radius）。 

 

图 044-1 

2、通过右键菜单输出到本地文件（TXT 格式）。 

 

图 044-2 

  

http://mp.weixin.qq.com/s?__biz=MzIzNDIyOTMwNw==&mid=2247488757&idx=1&sn=a5aa7f99208363cd7ad9f7408acab6ba&chksm=e8f8cfa1df8f46b73ab58169b526f87549b1bb93991bc3dcce039db7282f528682076fd3b8ef&scene=21#wechat_redirect
http://mp.weixin.qq.com/s?__biz=MzIzNDIyOTMwNw==&mid=2247488757&idx=1&sn=a5aa7f99208363cd7ad9f7408acab6ba&chksm=e8f8cfa1df8f46b73ab58169b526f87549b1bb93991bc3dcce039db7282f528682076fd3b8ef&scene=21#wechat_redirect
http://mp.weixin.qq.com/s?__biz=MzIzNDIyOTMwNw==&mid=2247488727&idx=1&sn=531b6c557d060d787d319363087441d7&chksm=e8f8cf83df8f4695dd151d86a314d5bb8f335596a8768950e8b8713be1644c9090d57d94a53b&scene=21#wechat_redirect
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3、用文本编辑器打开，删除前几行备注，并保存为.CRV 格式文件。 

 

图 044-3 

4、用 UM Input 打开车辆模型，添加一个参数符号，如：curvature，然后保存模型。 

 

图 044-4 
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5、用 UM Simulation 打开车辆模型，点开仿真控制界面，在 Identifiers | Identifier 

control 页面添加一个控制参数。 

 

图 044-5 

6、从 Identifier 下拉菜单中选择先前定义的参数符号 curvature。 

 

图 044-6 
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7、选择以 Points 离散点的形式指定纵坐标（Ordinate），读入先前保存的曲率.crv 文

件。 

 

图 044-7 

8、选择以 Variable 变量的形式指定横坐标（Abscissa），从变量向导创建 Distance 变

量，并拖入框中。 

 

图 044-8 
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9、从变量向导的 Identifiers 页面创建 curvature 时域变量，并显示在一个绘图窗口。 

 

图 044-9 

10、开始计算，下图显示的就是随着时间变化的曲率。 

 

图 044-10 
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045. 如何对 UM 模型进行加密和解密操作？ 

UM 软件有个小工具，可以对模型进行加密和解密操作，在有些时候可能派的上用场。

其主要原理就是将建模的明文文件 input.dat 转换为密码文件 input.dat.protected。加密后

的模型既可以直接用 UM Simulation 程序打开进行仿真，也可以在 UM Input 程序里通过

外部子系统导入另一个模型，组成更大的多体系统。 

 

图 045-1 
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一、模型加密过程操作步骤如下： 

1、从开始菜单找到 Universal Mechanism 9x64 | Tools。 

 

图 045-2 

2、双击运行 UM Model Encoder。 

 

图 045-3 

3、在 Model protection wizard 界面点击     按钮，选择一个目标模型的 input.dat 文

件。 

 

图 045-4 
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4、手动输入或自动生成（Generate password）一个密码（牢记，用于解密），勾选 Delete 

input.dat。 

 

图 045-5 

5、点击 Protect，生成加密文件，并自动删除源文件。 

 

图 045-6 

6、最后结果如图 045-7。 

 

图 045-7 
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7、用 UM Simulation 程序可以正常打开加密后的模型（带      标记）。 

 

图 045-8 

8、使用 UM Input 程序不能直接打开加密的模型，但可以通过外部子系统（External 

subsystem）的形式导入。 

 

图 045-9 

9、加密后的模型，其参数可以自由修改，前提是采用了参数化建模（强烈建议将每个

参数添加备注，便于用户识别）。 
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图 045-10 

二、模型解密过程操作步骤如下： 

1、运行 UM Model Encoder。 

2、选择待解密模型的 input.dat.protected 文件（注意：先从下拉菜单选择格式）。 

 

图 045-11 
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3、输入正确的密码，点击 Decode。 

 

图 045-12 

4、完成解密后，明文 input.dat 文件又出现在模型目录。 

 

图 045-13 
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046. 如何使用 UM 软件快速计算轨道结构频率响应？ 

线性化计算在工程振动分析中非常重要，譬如：对于复杂的轨道交通系统，经常会出

现一些所谓的异常振动，这些振动对于轨道设施和运载工具来说都是有害的，研究者希望

从轨道结构的频率响应来寻找一些蛛丝马迹。 

对于车辆-轨道耦合系统和车辆-轨道-下部结构耦合系统，UM Flexible Railway Track

柔性轨道模块能很好地进行时域仿真计算。然而，当前软件版本并不支持直接对柔性轨道

系统进行线性化分析，如轨道系统固有频率计算和频率响应分析。因此，我们只能尝试手

动建模的方法，操作如下： 

1、我们先在有限元软件里使用铁木辛柯梁单元建立一根足够长的钢轨模型（本例的钢

轨 24m 长，单元尺寸 0.3m，坐标区间[-12,12]）。 

2、选择恰当的界面节点（本例只选了两个端点，读者可以尝试选择更多的节点），运

行 UM.mac，计算出所需的主模态（本例提取了 160 阶）和静模态（界面节点数目的 6 倍）。 

3、通过 UM FEM 专用转换工具得到自由状态的弹性体 input.fss 文件，并通过 FE 子

系统导入到 UM Input。 

 

图 046-1 低阶模态 

 

图 046-2 高阶模态 
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4、建立轨枕（半枕/短轨枕）的几何和刚体，复制，复制……，总计 41 个。 

 

图 046-3 

5、创建轨枕刚体相对 Base0 的铰接，定义两个平动和一个转动自由度，再复制，复

制……，总计 41 个。 

 

图 046-4 
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6、分别在轨枕和 Base0、钢轨和轨枕之间建立空间弹簧力元，定义好基础和扣件的刚

度、阻尼参数，并保存模型（请记得将弹性体文件夹置于模型文件夹下）。 

 

图 046-5 

 

图 046-6 

7、用 UM Simulation 打开模型，在时域仿真控制界面为钢轨设置恰当的阻尼比（UM 

FEM 采用瑞利阻尼）。 

 

图 046-7 
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8、关闭时域仿真控制界面，打开线性分析工具，计算系统的固有频率，在动画窗口可

以观察各阶振动模态。 

 

图 046-8 

9、在 Linear vibrations 页面，设置 1300 个激振频率(1,1300[1300])，作用于钢轨上某

点(0.3, 0, 0)，激振力幅值为 20kN，方向为 Z 向（读者可尝试 Y 向加载），并定义钢轨位移

和加速度等变量。 

 

图 046-9 
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10、点击左上角的图标开始进行扫频计算，一般会在 5 分钟内完成。打开绘图窗口，

将考察变量拖入其中（横坐标是频率 Hz）。 

 

图 046-10 
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047. 如何使用 UM 软件生成短波随机不平顺样本？ 

传统的铁路车辆系统动力学仿真研究一般采用中长波的随机不平顺激励，如轨检车测

得的不平顺其点距通常为 0.25m，在 UM 软件里，这个值是 0.1m。然而对于车辆-轨道耦

合动力学计算来说，这种激励频率明显不够高，研究者往往需要使用更小点距的不平顺样

本，即短波不平顺。在以前的微文 UM Loco 输入短波不平顺的方法（查询代码：041）中

我们介绍了使用 Identities 方式加载短波不平顺激励的方法。那么如何使用 UM 软件来生

成短波不平顺的样本呢？下面就为您解答。 

1、运行 UM Simulation 程序，选择主菜单 Tools | Irregularity editor | Railway track，

打开铁路轨道不平顺样本制作工具。使用这个工具既可以用软件自带的几种轨道谱生成不

平顺样本，也可以自定义轨道谱，还可以输入实测的数据。 

 

图 047-1 

  

http://mp.weixin.qq.com/s?__biz=MzIzNDIyOTMwNw==&mid=2247488727&idx=1&sn=531b6c557d060d787d319363087441d7&chksm=e8f8cf83df8f4695dd151d86a314d5bb8f335596a8768950e8b8713be1644c9090d57d94a53b&scene=21#wechat_redirect
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2、这里我们以 Sato 谱为例，选择 Spectrum | Expression，在 Function 下面的框输入

1e-6*0.036/(w^3.15)，取消勾选Circular frequency，设置波长范围 0.01-1m，点击Compute，

随即在左侧绘图区就显示了一组随机不平顺。 

 

图 047-2 

3、不过，由于该工具本身的限制，采用这种方法生成的不平顺样本，其点距始终是

0.1m，且不可更改，因此无法满足车辆-轨道耦合动力学仿真研究的需要。 

 

图 047-3 
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4、注意，在输入功率谱密度函数表达式旁边有个…按钮，请将其点开，在曲线编辑器

会显示该功率谱密度函数曲线，点击保存按钮，保存为 crv 格式文件。 

 

图 047-4 

5、选择主菜单 Tools | Time history editor。 

 

图 047-5 
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6、如下图，这就是一个没有 0.1m 点距限制的不平顺样本生成小工具。 

 

图 047-6 

7、点击…按钮，打开曲线编辑器，点击      图标，加载刚才保存的 crv 文件。 

 

图 047-7 

8、取消选择 Circular frequency，设置样本区间如：0-1000m，点距 0.005m，谐波数

缺省为 1000 个（可修改）。 

 

图 047-8  
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9、点击 Calculate，程序就会生成一组样本，点击保存按钮，可得到 txt 格式的样本文

件，如图 047-9： 

 

图 047-9 

10、点击绘图按钮，可以在绘图窗口显示当前样本（单位：m）。 

 

图 047-10 
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048. 如何使用 UM 对数据进行分区统计？ 

大家知道，UM Simulation 程序里有 Statistics 和 Table processor 两个后处理工具，它

们都是对一条曲线上所有数据（或指定的一个区间）进行统计分析。然而有些时候，我们

需要将一条曲线划分为多个数据区间（如：5 秒一段，2 米一段），先分别统计每一段，再

合计。UM 软件是否有这个功能呢？答案是 Yes！ 

这个功能就隐藏在绘图窗口，如下图所示，在绘图窗口左侧选中某条曲线，点右键，

选择 Calculate statistical data，就是执行分区统计工作。 

 

图 048-1 

随即，就生成了一些离散点和柱状图，如图 048-2，数据区间和统计结果一目了然。 

 

图 048-2 
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需要注意的是，在执行分区统计前，应设置好分区参数：在绘图窗口点右键，选择

Options，在 Statistics 页面设置相邻区间中心距 a 和区间宽度 b；从 Functional 下拉菜单

选择所需的统计函数；结果展示方式选择 Both ways。 

 

图 048-3 

下图是一个滑动平均的直观演示（统计函数是 mean，中心距 a=0.13m，区间宽度

b=0.2m），分区统计值缺省以 x 标记显示，用户可自行修改。 

 

图 048-4 

最后，将分区统计获得的曲线拖入 Tools 主菜单里的 Statistics 或 Table processor，可

获得最终的统计值。 
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049. 不同点距的两条曲线，如何用 UM 进行叠加？ 

研究者有时候需要将两条曲线进行叠加操作，如果点距相同，则很好办；若是点距不

同，一般就得需要编写程序来插值处理。如图 049-1，点距 0.1m 的中长波不平顺样本和点

距 0.005m 的短波不平顺样本，在 UM 软件里能实现叠加操作吗？ 

 

图 049-1 

虽然软件没有现成的工具可以完成这一操作，但是我们可以通过简单的多体系统建模

和仿真技术来实现。 

1、运行 UM Input 程序，新建一个模型，随意添加两个几何体（形状和尺寸任意，可

设置不同颜色）。 

2、添加两个刚体，分别选择上述几何体，勾选自动计算质量和转动惯量。 

 

图 049-2 



                                                    

第 188 页 
 

3、为刚体 1 创建一个平动铰，如：沿 X 轴有平动自由度。 

 

图 049-3 

4、在平动铰的 Description 页面，勾选 Prescribed function of time（时间函数驱动的

运动），选择 File 类型，读入点距为 0.1m 的 txt 文件。 

 

图 049-4 

5、用同样的方法，也为刚体 2 创建一个沿 X 轴的平动铰。 

 

图 049-5 
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6、设置时间函数驱动的运动，加载点距 0.005m 的 txt 文件。 

 

图 049-6 

7、保存模型，建议将两个 txt 文件都放入模型文件夹。 

8、运行 UM Simulation 程序，加载模型。从变量向导定义两个刚体沿 X 轴的位移变

量，并显示在绘图窗口。 

 

图 049-7 
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9、点开时域仿真控制界面，在 Solver | Solver options页面，设置最大积分步长为 0.001s。 

 

图 049-8 

10、在 Solver | Simulation process parameters 页面，设置仿真时间 100s（本例样本为

100m 长），数据输出步长为 0.005s（点距就是 0.005m）。 

 

图 049-9 
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11、计算完毕，打开 Table processor，在 Transformation of variables 页面，添加一个

加法运算（+），分别将两个变量结果拖入，就实现了曲线叠加，下图右下窗口显示的是叠

加后的曲线。 

 

图 049-10 

提示：上述叠加操作也可以在计算前定义变量的时候进行（Tools-Wizard of variables-

Expression）。 
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050. 如何将 UM FRT 模块的铁木辛柯梁转换为欧拉梁？ 

UM Flexible Railway Track 模块自带的柔性钢轨是采用铁木辛柯梁理论的参数化有限

元模型（非模态法），研究者有时需要用欧拉梁来做一些对比分析。那么，我们能否将铁木

辛柯梁转换为欧拉梁呢？本文为您揭晓。 

1、安装好软件后，定位到本地目录：C:\Users\Public\Documents\UM Software 

Lab\Universal Mechanism\9\rw\FlexibleTrack 

2、用记事本打开目录下的 rails.rcs 文件，该文件包含了 UM FRT 模块自带的多个钢

轨的截面参数，其中每个钢轨截面的第一行语句均为：with RailCrossSection;，用户可以

按固定格式自定义新的钢轨截面。 

 

图 050-1 
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3、滑动滚轮，找到我们常用的 Chinese 60kg/m 钢轨对应的语句段，将其整体复制，

更改名称，并将剪切修正系数 ky 和 kz 都设置为 0，保存文件。 

 

图 050-2 

4、运行 UM Simulation 程序，加载一个车辆-轨道耦合模型，此时在缺省列表就显示

了新定义的欧拉梁截面，通过右键菜单即可赋给左右钢轨。 

 

图 050-3 
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5、以下是测试模型的部分结果对比（直线，无不平顺激励），蓝色为铁木辛柯梁，红

色为欧拉梁。 

 

图 050-4 轮轨垂向力 

 

图 050-5 磨耗功率 
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图 050-6 扣件力 

 

图 050-7 钢轨加速度 
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051. 如何用 UM 给车辆滚动台施加轨道不平顺激励？ 

一、准备适合滚动台的轨道不平顺激励文件 

1、请打开一个铁道车辆模型，按常规方法定义好轨道上的随机不平顺，到变量向导找

到跟随车轮的相应不平顺变量，创建它们并在绘图窗口显示。 

 

图 051-1 

2、这样通过一次仿真计算就能获得一个速度工况下每个车轮随时间变化的横向和垂

向不平顺激励，将其分别保存为一个文本格式文件。 
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图 051-2 

3、用记事本打开每个文件，删除备注行，并保存。 

 

图 051-3 
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二、给滚动台模型施加不平顺激励 

1、若无激励时，滚轮和 Base0 之间可直接用一个转动铰相连。为了施加激励，我们需

要在每个滚轮和 Base0 之间再引入一个刚体，可名之为激振器，并使得滚轮和激振器之间

为转动副。 

 

图 051-4 

2、激振器和 Base0 之间可用 Generalized Joint 连接，这种类型的铰可以在空间中任

意运动方向定义时间函数驱动的位移，先用一个 TC 将其置于初始理想位置。 

 

图 051-5 
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3、接着分别在横向和垂向定义 TTy 和 TTz，以文件形式读入前面得到的随时间变化

的不平顺激励。显然，这个激励能通过与之相连的滚轮传递给轮对。 

 

图 051-6 

最后，滚振台上的转向架模型效果如下图所示。 

 

图 051-7 
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052. UM9 系列仿真程序不能正常启动的一种原因及解决办法 

有部分用户在安装 UM9.1 版本软件时遇到一个共同问题：UM Input 程序能正常运行，

而 UM Simulation 程序则不能，软件提示：Initialization of the graphic subsystem is failed! 

Please reinstall the application. Program is terminated，如图 052-1： 

 

图 052-1 

经过多次测试，我们发现有一种特殊情况会导致此错误：当软件安装路径含有中文字

符时。 

 

图 052-2 

由于 UM9 系列版本的 Simulation 程序采用了全新的 OGRE 图形引擎，该引擎目前只

支持 ASCII 字符，笔者尝试了一个包含“UM 软件”的安装路径，就会出现这个错误。因此，

请确保安装路径无中文字符。此外，请在安装软件前确保国产杀毒软件已关闭或卸载，并

以管理员身份运行安装程序。如若还不行，则只有尝试重装系统。欢迎反馈！ 
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053. 为什么 UM 单轨模块调用的汽车模型，经常会减速到停止？ 

当我们用 UM Monorail 单轨模块加载软件自带的汽车模型时（注：公路车桥耦合仿真

是基于单轨模块实现的），经常会出现如下图所示的情况：车辆很快减速为 0，轮胎与地面

间的纵向力很大，像是在模拟制动工况。 

 

图 053-1 

这是什么原因呢？其实在用户手册第 12 章就有说明：我们在模拟汽车的一些静态工

况时，需要将车轮锁住，因此在车轮转动铰定义了转动刚度参数（cLocking）和转动阻尼

参数（dLocking），它们分别是角位移和角速度的函数。 
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图 053-2 

因此，在做动态仿真时，我们不希望有这两个转动阻力矩的存在，应该将它们设置为

0。通常，这两个参数在后悬子系统，请到 Identifiers 里面找到 cLocking，将其设置为 0。

而 dLcoking 参数是与之关联的，自动会变为 0，无需手动设置。 

 

图 053-3 

 

图 053-4 
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如此，我们在进行动态仿真时，车辆就不会发生减速到停止的现象了。 

 

图 053-5 
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054. 如何通过命令行操作或第三方软件运行 UM 仿真程序并执行

计算任务？ 

有用户咨询能否通过第三方软件运行 UM Simulation 程序并执行计算任务，目的是为

了实现某些优化仿真的自动迭代过程。其实在用户手册第 1 章就有相关说明，操作是非常

简单的，只是大多数用户都没从这里开始阅读，从而忽视了这一关键技术。UM Input 和

UM Simulation 程序都支持命令行的操作，当然就能被第三方软件（通常指的是编程语言

或优化软件）调用。本文以 UM Simulation 的命令行操作为例，特作说明。 

UM 仿真程序命令行操作的基本格式为：“[path to UmSimul.Exe]\UmSimul.exe” [path 

to object] [options]。该命令由三部分组成，仿真程序路径、模型路径和仿真选项。请务必

注意程序路径和模型路径之间、模型路径和仿真选项之间都有空格。下面我们来做一些测

试，请打开 Windows 系统的运行。 

1、输入以下代码，点确定。 

"C:\Program Files\UM Software Lab\Universal Mechanism\9\bin\UMSimul.exe"  

 

图 054-1 

实现功能：运行 UM 仿真程序 

 

图 054-2 
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2、输入以下代码，点确定。 

"C:\Program Files\UM Software Lab\Universal Mechanism\9\bin\UMSimul.exe" "

C:\Documents and Settings\All Users\Documents\UM Software Lab\Universal Mechani

sm\9\SAMPLES\Rail_Vehicles\AC4" 

 

图 054-3 

实现功能：运行 UM 仿真程序并加载自带的 AC4 模型 

 

图 054-4 

3、输入以下代码，点确定。 

"C:\Program Files\UM Software Lab\Universal Mechanism\9\bin\UMSimul.exe" "

C:\Documents and Settings\All Users\Documents\UM Software Lab\Universal Mechani

sm\9\SAMPLES\Rail_Vehicles\AC4"/s  
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图 054-5 

实现功能：运行 UM 仿真程序、加载自带的 AC 模型并自动调用上一次的工况配置进

行计算 

 

图 054-6 

4、输入以下代码，点确定。 

"C:\Program Files\UM Software Lab\Universal Mechanism\9\bin\UMSimul.exe" "

C:\Documents and Settings\All Users\Documents\UM Software Lab\Universal Mechani

sm\9\SAMPLES\Rail_Vehicles\AC4"/s /clast.icf /rlast.rwc 

 

图 054-7 

实现功能：运行 UM 仿真程序、加载自带的 AC 模型并自动调用上一次的工况配置进

行计算 

注：在第三部分用户可以自定义所需仿真的工况，前提是要先准备好配置文件，不同
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模型配置文件调用格式如下表。 

 

图 054-8 

上述命令行操作还可以在 DOS 命令窗口执行，如图 054-9： 

 

图 054-9 

因此，我们可以将自动执行计算的一个或一组命令写入文本文档，并保存为 bat 格式，

双击 bat 文件即可运行。 

 

图 054-10 

最后，给大家分享一个用 Matlab 软件调用 UM 程序及模型的例子，以供参考。 

dos('("C:\Program Files\UM Software Lab\Universal Mechanism\9\bin\UMSimul.e

xe" "C:\Documents and Settings\All Users\Documents\UM Software Lab\Universal Me

chanism\9\SAMPLES\Rail_Vehicles\AC4" /s /clast.icf)')   
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055. 在 UM 里连接外部导入的弹性体时，如何输入更精确的节点

坐标，以保证理想的初始状态？ 

刚柔耦合系统的建模与多刚体系统有一个不同之处，即：铰和力元的作用点必须在有

限元节点上。因此节点坐标的精确程度会对计算产生一些影响，特别是初始状态，严重时

可能一计算就会卡死。本文以一个简单模型为例说明。 

如图 055-1 所示，这是一个几何尺寸为 2m*1m*0.5m 的长方体，其中垂向网格均分为

2 份，横向网格均分为 4 份，纵向网格均分为 7 份。 

 

图 055-1 

现在，我们欲在上表面靠近中心处施加一个弹性约束。 

 

图 055-2 
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从特殊力元里找到 Bushing，连接 Base0 和长方体，Body1 和 Body2 的连接点坐标都

为(0.857, 0.5, 0.5)。 

 

图 055-3 

在 Description 页面定义各个方向的刚度系数，这里统一给 1e10。 

 

图 055-4 
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在对多体模型进行仿真计算前，一般需要检查其初始受力状态，是否符合预期，操作

如下： 

在仿真控制界面依次点击按钮 Tools-Test-Compute，这样就计算出零时刻各个力元的

状态，很明显，这个 Bushing 力元在 X 方向有很大的力。 

 

图 055-5 

这个分力就是由于我们在建模时输入的坐标精度不够造成的，那么怎么才能输入更精

确的坐标呢？当然如果你有更精确的数据可以直接输入。其实，手动选择模式是一个不错

的方法：首先确保动画窗口的鼠标选择模式是打开（按下）状态，同时平移模式不能开启。 

 

图 055-6 

在 Body2（对应弹性体）的连接点页面，点击箭头按钮 选择菜单 Select 

node in Window，将鼠标光标指向目标节点，点击一下即可。 

 

图 055-7 
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注意：光标形状应为 程序会自动将更精确的坐标值填入，然后手动将其复制到

Body1（通常是 Base0）的参数框即可。 

 

图 055-8 

保存模型，我们再进入仿真程序，执行初始力计算，你会发现误差变得非常小了。 

 

图 055-9 

  



                                                    

第 212 页 
 

056. 使用 UM 如何对指定区间的数据进行统计分析？ 

仿真计算得到的结果数据并非全部是有用的，有时候用户需要截取一个指定区间的数

据进行统计分析，如图 056-1：曲线的前面一段和后面一段数据是不需要的。 

 

图 056-1 

在绘图窗口任意空白处点右键，选择 Options，弹出窗口参数界面。 

到 Axes-Style 页面，找到 Set interval for X，将其勾选，设置横坐标时间的开区间(4, 

32)，点 OK。 

 

图 056-2 

这样设置后，从该绘图窗口输出到 Excel 表格或者拖入到 Table processor 进行统计分

析的变量其数据区间就限定在(4, 32)时间区间内。 
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在绘图窗口图表区点右键，选择 Show according to the ruler pointers，绘图窗口自动

调整为只显示该区间的数据曲线。 

 

图 056-3 

需要注意的是，即使如上述设置了时间区间，我们在直接输出 txt 格式文件（Save to 

file）时，仍然保存的是全部数据。下面介绍一个更为通用的方法。运行仿真程序，打开一

组结果文件（tgr 和 sgr），窗口空白区点右键，选择 Options of interval，在弹出窗口设置

横坐标的区间，点 OK。 

 

图 056-4 

然后，将列表中的变量结果拖入绘图窗口，这里的数据就与预定义区间相对应。 
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图 056-5 
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057. 如何在 UM 里观察超大尺寸有限元模型的约束模态振型？ 

我们知道，利用修正的 C-B 模态综合法从从外部有限元软件导入 UM 的弹性体初始

均为无约束的自由状态，用户需要在 UM 里通过铰或力元(推荐用 Bushing)施加边界约束。

随后，一般需要考察其约束状态的固有频率及振型。这可以通过仿真程序中的静态和线性

分析功能实现（Analysis-Static and Linear Analysis ）。然而，有时候用户可能处理一些特

大模型（如：长达千米的桥梁）。对于这种尺寸的模型，在观察约束模态振型时，即使把幅

值调到最大，也很难看出其振动的形状。 

 

图 057-1 

那么有没有什么办法可以让我们看得更清楚些呢？下面为大家介绍一种方法。请用

UM Input 建模程序打开模型，确保左侧选中 Object，再到右侧面板找到 Characteristic 

size，这个模型显示的比例参数默认为 1，可将其设置为一个比较大的数值，本例为 10000，

然后保存模型。 
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图 057-2 

进入仿真程序，会弹出如下提示：新图形引擎并不支持不为 1 的模型比例显示，不过

没关系，点击确定即可。 

 

图 057-3 

之后，如果有如下提示，建议选择第一项（from model description file input.dat）。 

 

图 057-4 

缺省的动画窗口采用的是新引擎，可能显示不准确，将其关闭即可。 
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现在，请从主菜单 Tools-Animation window (old engine)打开一个动画窗口，这个窗口

采用的是旧引擎。 

 

图 057-5 

在动画窗口通过右键菜单 Grid-No 可以取消背景网格。 

 

图 057-6 

这样，我们再进行线性分析，就可以很清晰地观察每阶约束模态的振型了。 

 

图 057-7 
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058. 如何使用 UM 仿真程序快速实现某些故障工况的模拟？ 

有时候需要研究一些特定故障工况下系统的动力响应，除了回到 UM Input 建模程序

修改模型外，我们其实可以直接在 UM Simulation 仿真程序中进行开、关操作，其方法如

下：打开仿真控制界面，到 Tools-Forces 页面，这里列出了模型中所有的力元。在每个力

元右侧，都有两个“√”符号，其中第一个表示开启，第二个表示计算雅可比矩阵（注意：雅

可比矩阵通常适用于刚性力元）。在这个页面，用户可以设置每个力元为开启或关闭状态。 

 

图 058-1 

以某车辆模型为例，我们尝试让每个转向架的一个垂向减振器失效。（注意：在对一个
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力元进行开、关操作时，如果其他子系统有同名的力元，会自动列出，缺省为一起更改，

取消勾选则不一起更改）。 

 

图 058-2 

按图 058-2 操作（第二步不用勾选，保持缺省即可），前后转向架左侧的二系垂向减振

器均不开启，表示这两个力元在仿真计算时不起任何作用。 

 

图 058-3 
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图 058-4 就是车上某点垂向加速度的对比（红色为减振器失效工况）。 

 

图 058-4 

同样的方法，对于车辆-轨道耦合模型，我们也可以单独设置轨道上的某些力元的状态。

如图 058-5 所示，我们禁用连接第 120 号轨枕与 Base0 的 Bushing 力元，使其为悬空状态。 

 

图 058-5 

当车辆通过时，轮轨垂向力如下（红色为失效工况）。 

 

图 058-6 
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059. UM 仿真过程中如何实时控制某些模型参数的变化？ 

在进行多体动力学仿真时，有时候用户期望在计算过程中人为地实时操控某些模型参

数的变化，进而得到预期的运动及响应。 

在 UM Base 模块下有个附加工具，叫做 Control Panel，它支持用户自己定义适合具

体模型的实时操控面板，这在机器人、工程机械、车辆和列车模拟器、以及油气钻井仿真

领域应用较多。 

我们以一个铁道车辆在曲线轨道上的碰撞为例简要说明其用法，希望对您有用。 

1、运行建模程序，新建一个模型，添加两个车辆子系统（建议以外部子系统形式导入）。 

 

图 059-1 

2、用“Points-Plane”接触力元定义车端接触作用（注：为简化之便，本例略去了车钩缓

冲装置）。 

 

图 059-2 
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3、添加一个“T-force”力元，定义后车车体上受到的一个外部作用力 fx，缺省为 0 即

可，保存模型。 

 

图 059-3 

4、进入仿真程序，选择主菜单“Tools-Contol Panel Editor”，打开操控面板编辑器。 

 

图 059-4 
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5、拖动鼠标，调整窗口和面板大小。 

 

图 059-5 

6、先选中工具栏上的滑动条按钮，然后到面板上点击一次，拖动鼠标调节大小和位置。 

 

图 059-6 

  



                                                    

第 224 页 
 

7、选中这个滑动条，然后在右侧指定对应的变量 fx（如下图操作）。 

 

图 059-7 

8、选好变量后，点击 OK。 

 

图 059-8 
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9、再到右侧设置变量 fx 的取值范围[0, 100000]，然后保存 cp 文件，关闭编辑器。 

 

图 059-9 

10、选择主菜单 Tools-Open Control Panel，加载制作好的操控面板，如图 059-10。 

 

图 059-10 

这样，我们在仿真过程中就可以随心所欲地调节这个外力 fx 的大小，从而改变后车的

运行速度了。 
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060. 如何用 Matlab 读取 UM 软件的计算结果？ 

在前面的微文中，我们介绍过通过命令行操作运行 UM Simulation 仿真程序自动执行

计算任务的方法。其实，所有支持命令行的第三方软件（如：Matlab、Isight）都可以实现。 

有用户问，能不能用第三方软件来读取 UM 软件的计算结果进行后处理分析呢？毕竟

对于同一个模型很多工况的分析，手动模式相对比较繁琐枯燥。 

我们知道 UM 软件每次计算的结果是一个.tgr 文件和一个.sgr 文件。其中文件.tgr 存

放的是变量名称，为文本格式；文件.sgr 存放的是所有结果数据，为二进制格式。理论上

任何程序语言都可以读取二进制数据文件，并以十进制形式进行输出。 

UM 软件提供了一个用 Matlab 读取 UM 计算结果的示例“LoadUMDataFile.m”。该文

件位于C:\Users\Public\Documents\UM Software Lab\Universal Mechanism\9\Utils目录下。

调用格式为：[res, name]=LoadUMDataFile('文件名') 

（注：结果文件和这个 m 文件应放于同一工作目录，文件名不含后缀） 

 

图 060-1 
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图 060-1 中红色框选的这一段是读取变量名称的，可能不适用多个变量的情况，但并

不影响结果分析，忽略即可。 

通过尝试，你会发现所有结果都输出在一列，这是由于缺省 n=1 所致。 

 

图 060-2 

通常仿真计算的结果不止一个变量，例如：当变量是 12 个，那这里的 n 就应该改为

13（第一列为时间）。 

 

图 060-3 

使用 Matlab 自动读取了 UM 结果数据，接下来的任务就是对不同的变量用不同的统

计函数或指标进行分析了。 

如此，整个仿真计算及后处理过程都可以轻松实现自动化。 
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061. 如何根据设定的条件输出动态变量？ 

UM 软件的变量向导提供了多体系统运动学和动力学仿真分析的多种基本变量，如：

位移、速度、加速度和力等，同时也支持用户自定义更复杂的变量。譬如，有时候用户需

要通过一些预设的条件来进行判断，以输出不同的结果。 

本文以某一铁道车辆模型为例，通过判断时域仿真过程中每一时刻车体与构架横向相

对速度和车体横向速度的方向关系来判断并输出不同的数值。 

1、运行 UM Simulation 仿真程序，加载车辆模型。 

2、点开变量向导，在轨道坐标系中创建车体上某点的横向速度变量。 

 

图 061-1 
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3、在轨道坐标系中创建前转向架上某点的横向速度变量。 

 

图 061-2 

4、切换到 Expression 表达式页面，在右侧界面缺省有一行表格。5、点击左侧运算符

号“-”，为第一行表格添加一个减法运算，此时会自动增加一行空表格。分别将前面创建的

车体速度和构架速度变量拖入运算符两侧，表示：_x1=vy(车体)-vy(构架)。 

 

图 061-3 
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6、先点击一下第二行表格的任意单元格，再点击左侧运算符“x”，添加一个乘法运算，

分别将第一行的“_x1”和车体速度变量拖入运算符两侧，表示：_x2=_x1*vy(车体)=(vy(车

体)-vy(构架))*vy(车体)。 

 

图 061-4 

7、在第三行添加 if...else 语句，缺省条件为<，双击将其修改为<=，并将变量“_x2”拖

入左侧，双击右侧单元格，输入数值 0。 

 

图 061-5 
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8、在 IF 的下一行添加一个“=”，双击变量框，输入数值 0，即当_x2≤0 时，变量_x3 的

输出值为 0。 

 

图 061-6 

9、在 ELSE 的下一行添加一个“=”，双击变量框，输入数值 1。注意，此行变量缺省

为_x4，应修改为_x3，表示当_x2＞0 时，_x3 的输出值为 1。 

 

图 061-7 
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10、最后，在 ENDIF 下一行添加一个“=”，并将前面的任一个_x3 变量拖入右侧，在

选中变量_x5 时，点击手形按钮创建变量。 

 

图 061-8 

备注：表格中各行的变量名以及最终输出的变量名和备注内容均可自定义。测试仿真

结果如下： 

 

图 061-9 

提示：这种基于条件判断的变量亦可用于 Identifier control，这样无需使用第三方控

制软件就能轻松实现车辆的主动和半主动悬挂控制了。 
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062. 如何正确地将轨枕有限元模型导入 UM 软件？ 

关于如何正确地将轨枕有限元模型导入 UM 软件，用来实现车轨耦合仿真，本文提出

一种方法，以供诸位参考。对于铁道车辆-轨道系统耦合仿真，首选 FRT 方案（UM Flexible 

Railway Track）。UM FRT 自带有全参数化的柔性轨道模型，包括钢轨（梁单元）、轨枕（刚

体）和扣件（Bushing 力元），并支持导入下部结构（如：浮置板、轨道板、桥梁、隧道、

道床等）的柔性体进行大系统耦合仿真。 

 

图 062-1 

目前版本自带的轨枕要么是刚体模型，要么忽略不计。由于某些研究需要，轨枕的柔

性必须考虑，那就得从外部有限元软件导入。从图 062-1 可知，UM FRT 对下部结构的节

点有严格的要求（两排绿色节点为扣件连接点）。 

显然，像图 062-2 这样的一根轨枕（梁单元）模型是不满足基本要求的。 
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图 062-2 

笔者曾见过有用户将多根轨枕建在同一个有限元模型里，作为一个整体导入UM软件。

采用这种方法，虽然扣件节点符合软件要求，但从 Craig-Bampton 方法的基本原理来看这

并不恰当。这里，我们为大家提供一种方法。 

1、我们可以在图 062-2 轨枕模型（长 2m，单元尺寸 0.25m）的基础上，分别在左、右

扣件节点处向前（+X 方向）伸出一根无质量的刚臂（长 0.4m，单元尺寸 0.2m），如图 062-

3 所示。这样，模型就满足了两排扣件节点的要求，只不过间距是 0.2m。 

 

图 062-3 
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2、经对比，图 062-3 和图 062-2 的轨枕模型具有相同的自由模态。 

 

图 062-4 

3、在 UM Input 中依次导入三根带刚臂的轨枕，按 0.6m 间距布置。 

 

图 062-5 
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4、分别为三根轨枕的 9 个节点添加约束（注意左右刚臂上的两个点无需加力），这里

选用了 Bushing 力元，并定义六向刚度和阻尼参数。 

 

图 062-6 

5、UM Simulation 中柔性轨道的分段设置如图 062-7。 

第一段：设置足够的长度（刚性轨枕或不计），以避免边界效应。 

 

图 062-7 
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第二段：对应第一个柔性轨枕（取消刚性轨枕），注意间距设置为 0.2m。 

 

图 062-8 

第三段：对应第二个柔性轨枕（取消刚性轨枕），注意间距设置为 0.2m。 

 

图 062-9  
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第四段：对应第三个柔性轨枕（取消刚性轨枕），注意间距设置为 0.2m。 

 

图 062-10 

第五段：注意这里的轨道长度（刚性轨枕或不计），且间距设置为 0.2m。（请读者思考

为何设置这一段) 

 

图 062-11 
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第六段：设置足够的长度（刚性轨枕或不计），以避免边界效应。 

 

图 062-12 

6、最后一步，很关键！请在仿真控制界面的 Tools/Forces 页面，将每根轨枕上的第 2

个和第 3 个扣件力关闭（取消√），如图 062-13 所示。这样，最终的轨枕间距都是 0.6m。 

 

图 062-13 
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计算时会有图 062-14 的提示，点击 Continue 即可。 

 

图 062-14 

 

图 062-15 

读者可自行尝试将刚臂变为一个 0.3m 长的梁单元或者其他有效的方法。 
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063. 如何通过第三方软件编写适用于 UM 软件的轨道不平顺激励

文件？ 

能否通过第三方软件来编写适用于 UM 软件的轨道不平顺激励文件？目前在 UM 软件

界面，用户一次只能处理一个或一组（四个）轨道不平顺文件，而有时用户需要大批量地

制作用于动力学仿真的不平顺文件。 

当我们尝试用记事本打开*.way 文件时，发现都是乱码，说明它不是十进制的。我们

知道 UM 软件计算的结果文件也不是十进制的，但可以通过 Matlab 等第三方软件读取并

转换为十进制。因此，可以借鉴如何用 Matlab 读取 UM 软件的计算结果？的方法试一试。 

1、首先，我们在 UM 软件界面准备好一个 500m 长的随机不平顺样本，文件名为

rail.way，波形如图 063-1。 

 

图 063-1 

2、运行 Matlab，设置工作目录，将 rail.way 文件置于工作目录。 

3、执行下列程序代码： 

 

图 063-2 

http://mp.weixin.qq.com/s?__biz=MzIzNDIyOTMwNw==&mid=2247490183&idx=1&sn=7c9d23e741beed8861c03cc2a5a714d4&chksm=e8f8c1d3df8f48c56d4d730c6ba1551935e044ca807d01455956088e55cac3291fec0938f2f0&scene=21#wechat_redirect
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4、经上述过程，Matlab 成功读取了 rail.way 文件中的 5000

个数据，并以一列的形式存储。注意，我们发现数据中并没有轨

道里程信息，因为程序缺省的点距是恒定的 0.1m，软件会自动

对号入座，故无需单列。 

 

 

 

5、然后，执行以下程序代码： 

 

图 063-4 

6、经上述过程，在工作目录会生成一个名为 rail.2way 的文件，大小与 rail.way 文件

一样。注意：需要将数据存储形式由列转为行，故执行了一次转置操作。 

 

图 063-5 

7、在 UM 软件界面读入 rail2.way，经对比它与 rail.way 文件数据完全一致。 

 

图 063-6 

因此，利用第三方软件生成 UM 仿真所需的不平顺文件是完全可行的。 

图 063-3 
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064. 从有限元软件导入 UM 的弹性体，怎样检验其正确性？ 

在使用 UM 软件进行刚柔耦合多体系统动力学仿真时，需要从外部有限元软件导入弹

性体。如何确保导入的弹性体模型正确，这是用户很关心的问题，因为这直接影响到最终

计算结果的可靠度。我们以一个简支梁模型为例，进行测试。 

1、首先，使用有限元软件建立一个矩形截面梁模型，其几何尺寸为：长 5m，宽 0.2m，

高 0.1m；定义材料参数：弹性模量 30GPa，泊松比 0.2，密度 2400kg/m3；采用实体单元划

分六面体网格，单元尺寸为 0.05m。如图 064-1 所示。 

 

图 064-1 

2、由于实体单元的节点只有 3 个自由度，不满足 Craig-Bampton 模态综合法的要求，

我们需要在两端（实际加约束的地方）分别添加一个具有 6 自由度的质量单元，并作局部

刚化，使得端面（实际约束的区域）节点的三个平动自由度与质量单元耦合，如图 064-2 所

示。 

 

图 064-2 

3、我们从有限元模型提取了 50 阶固有模态（两端都全约束）和 12 阶静模态（每端依

次放开一个自由度方向的单位位移），得到中间格式文件 input.fum。为便于之后的对比分

析，还单独计算了该模型的自由模态。 



                                                    

第 244 页 
 

4、运行 UM Input 程序，从 Tools 菜单选择 Wizard of Flexible Systems，加载 input.fum

文件。这是一个可视化的模态转换工具，既可以清楚地看到有限元软件计算得到的固有模

态和静模态，也可以看到正交变换后的自由模态。在这个界面，用户可以自由决定选择哪

些模态参与计算。 

 

图 064-3 

5、从计算精度的角度讲，自然是参与计算的模态数量越多越好，但是计算量也会随之

越大。特别是对于大规模的模型，应该有所取舍，在保证精度的前提下，提取足够的模态

即可。在统一选择 12 阶静模态的前提下，分别选择 12 阶、18 阶、24 阶、36 阶和 48 阶固

有模态，进行模态转换，得到自由模态文件 input.fss。选择方法如图 064-4 所示。 

 

图 064-4 
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6、将 UM 转换得到的自由模态与之前有限元单独计算得到的自由模态（前 10 阶）进

行对比，发现随着使用的固有模态数量增加，最大误差越来越小，如下图所示。在后面的

计算中，我们就采用 24 阶生成的 input.fss，姑且认为它的精度已满足我们的需求。 

 

图 064-5 

7、将 input.fss 弹性体导入 UM，使用 Joint 约束两端。注意：在 UM 中，打勾表示这

个方向是自由的。 

     

图 064-6 
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8、进入 UM Simulation 仿真程序，进行线性化分析，求得实际约束状态的模态频率，

如图 064-7 所示。 

 

图 064-7 

9、再回到有限元软件，设置与上述相同的边界条件，计算约束模态。模态频率对比如

下表，可见，误差非常小。 

约束模态计算结果对比 

阶数 ANSYS UM 误差 

1 6.463   6.463   0.00% 

2 12.832   12.832   0.00% 

3 25.805   25.805   0.00% 

4 50.956   50.953   0.01% 

5 57.889   57.890   0.00% 

6 102.490   102.491   0.00% 

7 113.300   113.307   0.01% 

8 159.300   159.325   0.02% 

9 161.850   160.679   0.72% 
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10 176.850   177.037   0.11% 

11 198.250   198.255   0.00% 

12 227.950   228.002   0.02% 

13 303.780   303.949   0.06% 

14 308.010   308.333   0.10% 

15 323.760   323.920   0.05% 

16 398.990   399.488   0.12% 

17 427.690   428.000   0.07% 

18 485.790   487.388   0.33% 

19 500.370   503.204   0.57% 

20 530.480   536.716   1.18% 

 

10、对上述简支梁模型，分别在有限元软件和 UM 软件中进行静力分析，在梁的跨中

节点施加向下 1000N 的力，求其位移。有限元计算的结果为 5.1252mm，UM 计算的结果

为 5.1243mm，误差仅为 0.09%，再一次验证了导入模型的准确性。 

 

图 064-8 
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11、对上述简支梁模型，分别在有限元软件和 UM 软件中进行定点动力加载，

F=fz*sin(w1*t)，其中 fz=1000，w1=2。 

跨中垂向位移计算结果如图 064-9 所示，吻合度很高。 

 

图 064-9 

12、对上述简支梁模型，分别在有限元软件和 UM 软件中进行移动力加载。 

跨中垂向位移计算结果如 064-10 图所示，结果相差无几。 

 

图 064-10 
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好了，写到这里，相信读者对 UM 软件刚柔耦合模型验证的方法已经了解差不多了。

当然，可能也有用户会质疑这只不过是个简单的小模型，如果是复杂的大模型呢，它还准

确吗？图 064-11 就是一个 32m 铁路简支梁的模型对比，无论是用 Joint 还是 Bushing 力元

进行支座约束，算出的模态频率都与有限元软件结果非常接近。 

 

图 064-11 

P.S.: 用户在导入自己建立的模型时，首先应该确保模型的刚体属性前后一致，即质量

和转动惯量。 

  



                                                    

第 250 页 
 

065. 如何从 UM 软件输出轮轨型面的离散点坐标？ 

在 UM 软件中，轮轨型面是以一组离散的平面坐标点通过不同的拟合方式形成的，有

直线、B 样条曲线、三次样条曲线和圆弧曲线多种。 

 

图 065-1 

像上图这个标准的 JM 车轮踏面，其关键点只有 10 来个，有时用户需要获得更密集的

离散点，如果不借助外部 CAD 软件，只用 UM 如何实现呢？操作如下： 

1、运行 UM Simulation，打开一个绘图窗口。 

 

图 065-2 
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2. 在左侧点右键，选择 Load from file。 

 

图 065-3 

3.  在弹出的文件浏览器窗口，选择*.wpf 或者*.rpf 格式。 

 

图 065-4 
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4. 选中一个车轮或钢轨型面文件，加载到绘图窗口。在绘图窗口选中曲线点右键，选

择相应的菜单输出到 Excel 或文本文件即可。 

 

图 065-5 

5. 输出结果如下图所示，程序自动按 0.1mm 的间隔进行离散。 

 

图 065-6 
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066. 如何使用 UM 的轨道不平顺工具生成中国高速铁路轨道不平

顺样本？ 

UM 软件 Loco 模块自带了美国谱和德国谱，但是在使用 UM 软件模拟中国高速动车

组在高速铁路上的运行工况时，应该使用符合我国铁路特情的轨道谱。那么能否使用 UM

自带的轨道不平顺工具生成中国高速铁路轨道不平顺样本呢？答案是肯定的，本文为您揭

晓。 

早在 2014 年 10 月 30 日，国家铁路局就发布了中华人民共和国铁道行业标准之《TB/T 

3352-2014 高速铁路无砟轨道不平顺谱》，以下简称标准。标准给出的轨道谱是功率谱密度

函数的形式，量纲为 mm2/(1/m)，空间频率范围 0.005-0.5(1/m)，即波长范围 2-200(m），公

式如下： 

 

其中 f 为空间频率（1/m）；A 和 k 是拟合系数。虽然上述表达式在形式上比美国谱和

德国谱都简洁，但无论是描述轨道垂向的高低不平顺和水平不平顺，还是描述轨道横向的

轨向不平顺和轨距不平顺，统统都是分段函数，每一段对应不同的波长区间，采用不同拟

合系数，如图 066-1。 

 

图 066-1 
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因此，每一种不平顺都需要多步操作，并将各段的数据点拼接为一段。 

在开始 UM 的工作前，我们先根据标准中表 1 和表 2 的数据，整理好适合 UM 的功率

谱密度函数表达式，如下： 

高低不平顺（Z+） 

分段 功率谱密度函数表达式 波长范围（m） 

第一段 1e-6*1.0544e-5/w^3.3891 53.5-200 

第二段 1e-6*3.5588e-3/w^1.9271 21.1-53.5 

第三段 1e-6*1.9784e-2/w^1.3643 6.5-21.1  

第四段 1e-6*3.9488e-4/w^3.4516 2-6.5 

 水平不平顺（Z-） 

分段 功率谱密度函数表达式 波长范围（m） 

第一段 1e-6*3.6148e-3/w^1.7278 38.8-200 

第二段 1e-6*4.3685e-2/w^1.0461 8.6-38.8 

第三段 1e-6*4.5867e-3/w^2.0939 2-8.6 

轨向不平顺（Y+） 

分段 功率谱密度函数表达式 波长范围（m） 

第一段 1e-6*3.9513e-3/w^1.8670 22.2-200 

第二段 1e-6*1.1047e-2/w^1.5354 8.1-22.2 

第三段 1e-6*7.5633e-4/w^2.8171 2-8.1 

 轨距不平顺（Y-） 

分段 功率谱密度函数表达式 波长范围（m） 

第一段 1e-6*5.4978e-2/w^0.8282 9.2-200 

第二段 1e-6*5.0701e-3/w^1.9037 3.4-9.2 

第三段 1e-6*1.8778e-4/w^4.5948 2-3.4 

注意： 

1)、UM 软件统一用字母 w 来表示频率，既可以是圆频率，也可以是空间频率，在界

面有选项予以指定。 

2)、系数 1e-6 是将表达式转换为国际单位，量纲变为 m2/(1/m)；最后输出不平顺时再
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统一换算为 mm。 

下面，我们就以左、右轨垂向不平顺为例进行演示。 

1、运行 UM Simulation 程序，打开铁路轨道不平顺工具。 

 

图 066-2 

2、点击 Spectrum-Expression，界面如图 066-3。 

 

图 066-3 
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3、在 Function 处输入高低不平顺的第一段表达式：1e-6*1.0544e-5/w^3.3891，并取消

勾选 Circular frequency，设置 Lmin 为 53.5，Lmax 为 200。 

 

图 066-4 

4、点击表达式旁边的三个点图标，该段功率谱密度函数随空间频率变化的图像随即显

示在曲线编辑器中，点击保存，命名为 Z+1。 

 

图 066-5 
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5、上一步保存的文件为 UM 的 crv 格式，可以用记事本打开，可以看到它是三列数

据的形式。 

 

图 066-6 

6、采用与第 3、4 步相同的方法，分别获得高低不平顺第二段、第三段和第四段的数

据点文件，记作 Z+2，Z+3，Z+4。7、依次把第二段、第三段和第四段的数据复制到第一

段末尾（记事本操作），拼接为一个文件，记作 Z+。 

8、采用与第 3-7 步相同的方法，先分别获得水平不平顺第一段、第二段和第三段数据

点文件，记作 Z-1，Z-2，Z-3，最后拼接成水平不平顺的数据文件记作 Z-。 

9、切换到 Spectrum-Points 页面，这里可以通过输入功率谱密度函数的数据点来生成

随机样本，如图 066-7，设置样本长度，并取消圆频率选项。 

 

图 066-7 
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10、点击三个点图标，弹出曲线编辑器，读入第 7 步得到的 Z+文件。 

 

图 066-8 

11、点击 OK 后，生成一组随机不平顺，每点击一次 Compute，样本会随机更新一次。

如图 066-9，保持缺省的系数为 1，将高低不平顺样本复制到上面的窗口。 

 

图 066-9 
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12、接着，再次点击三个点图标，读入第 8 步准备好的 Z-文件，点击 OK。 

 

图 066-10 

13、如下图，将系数改为 0.5，上移水平不平顺样本，上面的窗口显示为合成后的左轨

垂向不平顺，即：Z-left=(Z+) + 0.5*(Z-)，点击上面的保存按钮。 

 

图 066-11 
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14、紧接着，将系数改为-0.5，上移同一个水平不平顺样本(切勿再点 Compute)，并取

消勾选中间那个 0.5*Spectrum。这样，上面的窗口显示为合成后的右轨垂向不平顺，即：

Z-right=(Z+) - 0.5*(Z-)，点击上面的保存按钮。 

 

图 066-12 

读者可参考以上步骤自行完成左轨横向不平顺和右轨横向不平顺样本的制作。 
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067. 从外部 CAD 软件导入几何模型到 UM 软件的 N 种方法 

虽然 UM 软件本身具有比较强的几何建模功能，但为了让仿真模型显示的更加逼真，

用户通常需要从外部 CAD 软件导入几何模型。导入方式和工具有很多，总的来说，可分

为以下 6 种。 

▪ 直接导入 

▪ 专用接口导入 

▪ 3DS 文件转换器 

▪ STL 文件转换器 

▪ STEP 和 IGES 文件转换器 

▪ CADLook 转换器 

下面我们依次来介绍。 

一、直接导入 

这种方法适用于当 UM 软件和三维软件（Solidworks, Inventor，Kompas-3D）安装于

同一台计算机的时候，相应的图标会亮起。不妨以俄罗斯著名的三维软件 Kompas-3D 为

例进行演示。 

1、请运行 UM Input（无需新建模型），点击工具栏图标或者选择菜单 Tools-Import 

from CAD-Kompas。 

 

图 067-1 
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2、软件会提示选择需要导入的 Kompas-3D 模型（注：*.m3d 为零件，*.a3d 为装配

体）。 

 

图 067-2 

3、选中某个零件或装配体模型后，Kompas-3D 会自动运行，并自动将模型转换加载

到一个新建的 UM 模型里，真是无缝连接。 

 

图 067-3 
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4、由于这是一个装配体模型，导入 UM 后会显示 2N 个几何、N 个刚体及 N 个铰。

一般来说，我们需要将无相对运动的刚体合并为一个刚体。UM 软件也提供了相应的工具，

如图 067-4 所示，在任一刚体页面，会出现一个 Parts 标签项。 

 

图 067-4 

5、点击 Parts，随即出现带复选框的刚体列表，根据需要选择部分或所有刚体（这里

我们通过右键菜单进行全选操作），再点击 OK。 

 

图 067-5 
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6、这样，模型树中 N 个刚体就变为了 1 个刚体，2N 个几何就变为了 N+1 个几何，其

中，前 N 个是各个零件的几何，最后 1 个是前 N 个的装配结果（引用关系），并用来赋给

刚体。如果删除了前面的 N 个 Part，显然最后一个装配体几何也将变空。 

 

图 067-6 

7、若需要将模型树中的所有几何也都完全合并为一个几何，软件也是支持的。先在模

型树选中最后一个几何（gopart...），然后在右侧面板点击向下的手指图标，选择 All GEs。 

 

图 067-7 

8、最终，显示为一个独立的几何。在模型树中选中它，点击工具栏上的保存文件图标

或选择菜单 Edit-Copy to file，保存为*.img 格式文件，以后在建模时就可以使用（工具

栏图标 或选择菜单 Edit-Read from file）。注意：这里的操作并不是保存和打开模型。 
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图 067-8 

温馨提示：在第一、3 步，装配体几何自动导入 UM 后，如果进行了保存 UM 模型的

操作，此时在文件夹里会生成 input.dat 和 input.umd 文件。 

如果按正常方式打开模型（input.dat），是没有 Parts 选项的，无法进行装配和合并操

作。 

 

图 067-9 
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只有通过菜单 File-Open *.umd 选项打开模型，才会有 Parts 选项，可以进行装配和合

并操作。 

 

图 067-10 

二、专用接口导入 

这种方法适用于当 UM 软件和三维软件（Solidworks, Inventor，ProE, Creo, UG）安

装于不同的计算机的时候。UM 实验室为这些常用的主流 CAD 软件分别开发了专用转换

接口，请到 QQ 群下载相应的接口程序。下面以 Solidworks 为例进行演示。 

1、安装好 SW 专用接口程序 swtoumaddin.exe，运行 SW，打开一个模型，会发现增

加了 UM Converter 选项，点击 Export to UCF file，生成*.ucf 格式文件（UM CAD Format）。 

 

图 067-11 
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2、将上一步生成的*.ucf 格式文件复制到安装有 UM 软件的计算机。 

3、运行 UM Input 程序，点击工具栏图标或者选择菜单 Tools-Import from CAD-Files 

UM CAD(*.UCF)，选择拷贝过来的*.ucf 格式文件。 

 

图 067-12 

4、UM 软件会自动新建一个模型，后续的装配、合并操作与第一节 4-8 步介绍的方法

完全一样，最后保存为*.img 格式文件。 

 

图 067-13 
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三、3DS 文件转换器 

3Dmax 软件是功能强大的三维造型设计软件，UM 支持导入其*.3ds 格式文件。 

1、运行 UM Input 程序，点击工具栏图标或者选择菜单 Tools-Import from CAD-Files 

*.3DS and *.ASC。 

 

图 067-14 

2、在弹出的 Image converter 3ds ->UM 界面，选择一个已有的*.3ds 文件。 

 

图 067-15 
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图 067-16 

3、在 Unit 处可以选择不同的长度单位或设置比例（注意：Dimension 那里显示的是导

入 UM 后三个方向最大尺寸，其单位是 m）。 

 

图 067-17 

4、点击 Save，保存为*.ucf 格式文件。 
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5、按图 067-12 所示(Import from CAD-Files UM CAD)，打开*.ucf 格式文件，保存几

何模型为*.img 格式即可。 

 

图 067-18 

如果是装配体模型，请参考第一节 4-8 步进行后续操作。 

四、STL 文件转换器 

1、运行 UM Input 程序，点击工具栏图标或者选择菜单 Tools-Import from CAD-File 

*.STL。 

 

图 067-19 
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2、在弹出的转换器界面，点击 按钮，选择已有的某个 STL 格式文件。 

 

图 067-20 

3、在 Unit 处选择合适的单位或者设置比例（注意：Dimension 那里显示的是导入 UM

后三个方向最大尺寸，其单位是 m），点击 Accept。 

 

图 067-21 

4、此时 UM 软件自动新建一个模型来显示导入的几何，后续操作与前面介绍的方法

一致，最后保存*.img 格式文件即可。 

 

图 067-22 
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五、STEP 和 IGES 文件转换器 

UM 实验室开发了一个用于转换 STEP 和 IGES 格式的接口，请从用户群下载

cadtoumconverter.exe，双击安装即可。 

1、运行 CADToUMConverter，点击 Select File，选择已有的一个 STEP 或者 IGES 格

式文件。 

 

图 067-23 

2、点击 Load File。 

 

图 067-24 

3、选择几何精度等级，然后点击 Get dada from file。 
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图 067-25 

4、选择合适的单位，点击 Export to UCF file。 

 

图 067-26 

5、通过菜单选项或者工具栏图标打开上一步获得的*.ucf 文件，最后保存*.img 格式文

件即可。 

 

图 067-27 
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注意：如果选择了 Separate object onto parts，那么导入 UM 后就是一系列零件。 

 

图 067-28 

六、CADLook 转换器 

CADLook 是一个专业的第三方 CAD 模型查看和转换软件。UM 可以借助它导入一些

复杂的几何模型，支持 STEP、IGES、X_T 和 SAT 格式。 

1、请从 CADLook 官方网站下载软件 CADLook Viewer/Translator，安装好后，请从

其官网申请 15 天的试用许可。 

2、运行 UM Input，选择菜单 Tools-Options，按图所示设置 CADLook 的程序路径。 

 

图 067-29 
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3、点击工具栏图标或选择菜单 Tools-Data import via CADLook。 

 

图 067-30 

4、选择 CADLook 支持的某个中间格式文件。 

 

图 067-31 

5、在转换界面可以调整几何精度。 

 

图 067-32 
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6、点击 OK，开始转换。 

 

图 067-33 

7、转换完成后，点击 Accept，自动将几何模型导入 UM，后续装配和合并操作与前文

介绍的方法完全一样，最后保存为*.img 格式文件即可。 

 

图 067-34 

特别提醒：通过以上接口进行几何模型导入时，最好保证模型名称及路径均不包含中

文、空格等特殊符号，否则可能失败。 
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068. 如何使用鼠标选择刚体标记点和弹性体节点来自动填充坐

标？ 

UM 软件是否支持这样的操作：先在物体上先定义好一些标记点，然后在建铰和力元

的时候选用。答案是肯定的。对于 UM 里的任一刚体，在其右侧面板都有一个 Points 标签

项。在这里可以定义很多个标记点，而且这些点的坐标可以参数化。举例如图 068-1： 

 

图 068-1 

注意：必须按下动画窗口工具栏的图标 ，以激活鼠标选点模式。 

 

图 068-2 
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在任一铰或力元的页面，一般都这样的图标 ，这就是用来选点的。点击它，将光标

移动到刚体上预定义的标记点处，直到光标变为图 068-3 这样。 

 

图 068-3 

此时，点击一下，程序就自动将该点的坐标输入到铰点或力元连接点处。 

 

图 068-4 

  



                                                    

第 279 页 
 

对于从外部导入的柔性体，由于铰和力元只能作用于有限元节点上，因此所有节点就

是标记点。 

如图 068-5 所示的一个正方形，边长为 0.2m，均分为 16 份，单元边长为 0.0125m。选

取了四个角点附近的节点作为 Interface nodes，而列表中显示的坐标仅有三位小数。如果

建铰或力元时直接使用这些坐标，显然会产生误差，导致初始有较大的力存在（F=k*Δx）。 

 

图 068-5 

这时，我们就得借助鼠标选点工具，获得其精确的坐标，操作如下： 

 

图 068-6 
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选择 Select interface node，选中目标点，点击 OK，程序就自动填充了精确的坐标。 

 

图 068-7 

其实，UM 软件支持在任意节点上施加外力，不局限于 Interface nodes，选点工具里

的其他选项（Select node in window，Select from nearest 和 Find node）都可以用来精确选

点。 

 

图 068-8 
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需要提醒的是，如果建模过程中使用过 平移(或缩放、旋转)模式，一定要将其取消，

同时确保 为按下状态，否则无法通过鼠标选点。当识别到节点时，鼠标光标如图 068-

9 所示。 

 

图 068-9 
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069. 如何导入渲染素材自定义 UM 的仿真场景？ 

两年前，UM 软件发布了一个名为 UM Scene 的模块，用于帮助用户构建逼真的仿真

场景。该模块提供了一个丰富的素材库，用户可以随意组合调用。 

 

图 069-1 

同时，软件也支持用户通过自定义操作来扩展素材库。我们通过一个简单的例子为大

家介绍基本流程。 

1、请从用户群或官网下载最新版的 UM 软件主程序和 UMSceneCollection.exe 素材库

安装包，并依次安装（以管理员模式）。素材库自动安装于 UM 软件的数据目录：“C:\User

s\Public\Documents\UM Software Lab\Universal Mechanism\9\Scene data”。2、运行 3DSm

ax 程序，打开位于“C:\Users\Public\Documents\UM Software Lab\Universal Mechanism\9\

Scene data\Samples\Skoda_Yeti\Autodesk3dsMaxModel” 目录下的 Skoda_Yeti.max 模型。

（注：本例使用 3DSmax2018+ Easy Ogre Exporter，其他软件如 Blender、Maya、COLLA

DA、MilkShape 3D 或 Assimp 也是支持的。） 

 

图 069-2 
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3、该模型由四个对象组成，我们先将其合并为一个。在场景管理器选中任一个对象，

接着在视图窗口点右键，选择菜单 Convert to | Convert to Editable Poly。 

 

图 069-3 

4、紧接着，在视图窗口点右键，选择菜单 Attach。 

 

图 069-4 

5、然后依次点击其他三个对象，如有弹出窗口，请按图 069-6 设置。 

 

图 069-5 
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图 069-6 

6、合并后如图 069-7。 

 

图 069-7 

7、选择主菜单 File | Export | Export，指定一个路径（不含非法字符），选择 Ogre Scene

格式。 

 

图 069-8 
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8、选择 Ogre1.8 版本，按图 069-9 设置，点击 OK。 

 

图 069-9 

9、在指定目录下生成了一些文件和文件夹，于我们有用的信息位于 bitmap、material

和 mesh 三个文件夹。 

 

图 069-10 
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10、新建一个文件夹，如：mycar，将 bitmap 里的所有图片、material 和 mesh 文件

夹里的文件复制到这个文件夹下，删除其余不需要的文件和文件夹。这里，我们将 material

文件也改了一下名：mycar。 

 

图 069-11 

11、用记事本打开 mycar.material 文件，将所有 ambient、specular 和 emissive 的前

三项参数都设置为 0。 

 

图 069-12 
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12、在所有贴图文件名前方加入相对路径 mycar/。 

 

图 069-13 

13、复制“C:\Users\Public\Documents\UM Software Lab\Universal Mechanism\9\Scene 

data\Samples\User objects”路径下的 SampleUserBase.xml 文件过来，与文件夹 mycar 并列

放置，重命名为 mydata.xml。 
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图 069-14 

14、示例文件中包含了三个素材，我们只保留一个，并修改名称和序号如图 069-15。

（注意：模型及材质名称需与 material 文件里的一一对应，序号需≥20000000，并确保唯一

性） 

 

图 069-15 
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15、将文件夹 mycar 压缩为 zip 格式，重命名为 mydata.zip，与 xml 文件一致，这样

我们就制作好了仅包含一个素材的自定义素材库。 

 

16、复制 mydata.xml 和 mydata.zip 文件到“C:\Users\Public\Documents\UM Software 

Lab\Universal Mechanism\9\Scene data\User objects”路径下。 

 

17、复制“C:\Users\Public\Documents\UM Software Lab\Universal Mechanism\9\Scen

e data\Samples\User objects”路径下的 SampleScene.scene 文件到“C:\Users\Public\Docume

nts\UM Software Lab\Universal Mechanism\9\Scene data\Scenes”路径下，重命名为 MySc

ene.scene。 

 

图 069-16 
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18、用记事本打开 MyScene.scene 文件，这里引用了多个素材，本例我们只需要一个。 

 

图 069-17 

19、设置如图 069-18，注意素材名称和 ID 需与 xml 文件保持一致。 

 

图 069-18 
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20、运行 UM Simulation，打开任意一个模型，然后选择菜单 Tools-Scenes，打开 UM

的场景管理器。 

 

图 069-19 

21、从 UM 的场景管理器中选择 MyScene，右键-Make the scene active。 

 

图 069-20 
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22、激活自定义的场景后，动画窗口显示如图 069-21。 

 

图 069-21 

需要说明的是，这类场景并不参与动力学计算，只有在 UM Sensors 模块，才能被各

类传感器识别，可用于高级驾驶辅助系统的仿真模拟。 

 

图 069-22 

读者可以尝试激活场景库中的各类场景。 

 

图 069-23 



                                                    

第 293 页 
 

此外，UM Quick Track 模块实际就是基于这个功能实现的，能显示高精度的钢轨、扣

件、轨枕和道床。 

 

图 069-24 

联合使用 UM Scene 和 UM Quick Track 模块，可让仿真显得更加逼真，欢迎申请试

用。 

 

图 069-25 
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070. 如何正确地选择和处理弹性体的界面节点？ 

我们在使用 UM 软件时，经常需要导入外部柔性体，进行刚柔耦合系统建模和仿真分

析。其中，选择合适的界面节点是保证导入的柔性体合理可用的关键所在。 

以下内容翻译自 UM 软件用户手册第 11 章，供用户参考。选择界面节点时应遵循以

下几个准则： 

1、对于任何一个弹性体，我们需要选择若干个界面节点来施加特定的约束，求解静力

模态（每次计算时仅一个界面节点一个自由度方向具有单位位移，其余为全约束）和固有

模态（全约束）。必须确保在计算静力模态时，该柔性体不会呈现出刚体运动。否则，该模

型无法用 Craig-Bampton 模态综合法来描述，因为在数学上是错误的。如图 070-1 所示，

（a）是错误的，（b）是正确的。 

 

（a）错误的界面节点设置 

 

（b）正确的界面节点设置 

图 070-1 选择界面节点 
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图 070-1 中两个模型均由 8 节点实体单元组成，每个节点都只有 3 个平动自由度。图

070-1（a）只选了两个界面节点，当给定其中一个节点沿 X 轴或 Z 轴单位位移来计算静力

模态时，模型无法保持稳定。例如：节点 2 沿 X 轴的位移会使柔性体沿 Z 轴旋转（刚体运

动），因为节点没有转动自由度，所以固定节点 1 并不能阻止这样的旋转。而图 070-1（b）

选择了四个界面节点，则可以顺利地计算出静力模态。 

2、在 UM 软件中，除接触力以外的所有外力都只能施加在有限元模型的节点上。为

保证求解精度，建议选择这些有外力作用的所有节点作为界面节点（译者注：对于某些土

木结构，其边界条件极其复杂，外力作用点众多，应适当变通处理，结合第六条准则，酌

情减少界面节点数量）。外力对柔性体的影响直接取决于节点中对应的自由度是否存在。我

们来考虑图 070-2 所示的情况，一个由实体单元组成的矩形板，四个角点分别通过一个线

性力元连接地面。板的横向或纵向位移会使单元内部产生非零力矩，但由于实体单元节点

没有转动自由度，在模拟过程中会忽略产生的转矩分量，也就是说该弹簧的角刚度无法对

仿真结果产生影响。如果该板实际上或设计时会受到较大的扭矩，那么这种建模方式在物

理意义上是不合理的。为了正确地模拟这样的模型，需要对实体单元模型进行进一步处理，

使得每个界面节点具有 6 个自由度。 

 

图 070-2 导入到 UM 的弹性体 

3、上一条准则同样适用于铰的支反力。例如，如果用铰（0 自由度）来固定图 070-2

中的板两个角点（去掉四个弹簧），板将围绕连接这两个节点的轴自由旋转，就像一个球铰

（只限制了平动自由度）。 

4、在实际工程中，柔性体上的任何外力都是通过理想作用点周围的某些区域传递的。
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也就是说相较于集中力，将力分布在多个相邻节点上的模型会更加真实。 

5、如果界面节点没有 6 个自由度，通常意味着无法生成正确的约束方程，甚至根本无

法生成约束方程。 

6、如果选择的界面节点相互之间距离太近，则会导致结果中出现过高的频率（译者注：

对于某些特殊结构需要进行取舍，选择主要的承力部位作为界面节点）。 

 

下面，我们举一个例子进行说明。如图 070-3 所示，柔性连杆两端分别与滑块和曲柄

相连。 

 

图 070-3 具有柔性杆的曲柄连杆机构 

显然，柔性连杆两端分别需要选择一个界面节点。第一个界面节点应设置在滑块连接

端的截面中心，第二个界面节点应设置在另一端圆孔中心。 

 

图 070-4 实体单元划分的连杆 

由于柔性连杆采用实体单元建立，故需要增加具有六个自由度的节点，并设置约束（局

部刚化）。 

下面以 ANSYS 为例，介绍如何使界面节点具有 6 个自由度，并且通过某个区域来传

递力。 

方法 1. 添加质量点和约束方程利用具有非零惯性矩的质量点可引入六自由度，即添

加 MASS21 单元。质量点的惯性参数相对于整个柔性体来说应该非常小。在有限元网格中

加入质量单元后，质量点上的转动自由度与柔性体的平动自由度并不相连。因此，需要增
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加约束方程。 

在 ANSYS 中可以这样来实现： 

GUI 操作： 

Preprocessor>Coupling/Ceqn>Rigid Region 

APDL 命令： 

CERIG,MASTER,SLAVE,UXYZ 

其中 MASTER 是主节点（界面节点）的编号，SLAVE 从节点（通常是一组相邻节点）

的编号，UXYZ 表示耦合所有平动自由度。此外，用户也可以使用 CE 命令创建约束方程，

这在 ANSYS 用户手册中有详细描述。 

如上所述，在连杆的滑块连接端中心处添加一个节点，定义为质量单元，然后添加约

束方程来创建一个刚性区域（从节点是原实体单元的 9 个节点），如图 070-5 所示。 

 

图 070-5 滑块端的刚性区 

采用同样的方法，定义连杆的曲柄连接端的界面节点和刚性区，结果如图 070-6 所示。 

a）在圆孔中心添加一个节点； 

b）定义为质量单元； 

c）建立质量点和内圆柱面的所有节点的约束方程。 

 

图 070-6 圆孔处的刚性区 
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方法 2. 使用梁单元 

另一种有效的方法是使用大刚度的梁单元。在 ANSYS 中，可以使用 BEAM4 类型的

单元。梁的质量要小，刚度要高，否则柔性体的固有模态和频率可能会改变。使用了梁单

元，则不需要在界面节点上创建质量点，因为梁单元的每个节点都有 6 自由度，如图 070-

7 和图 070-8 所示。 

 

图 070-7 滑块端的梁单元 

 

图 070-8 圆孔内的梁单元 


